
QuickVerse for Windows Help Contents

Welcome to the QuickVerse for Windows online help system. Here you'll find information on operating 
the program and instructions for using all of QuickVerse's menu options and screen elements. The help 
system has been divided into different topics to make using it as easy as possible. Each general topic is 
represented by one of the buttons below. You can move to an area by clicking its button. The topics are 
interconnected and linked so that you can move quickly from one area directly to another by clicking icons 
or underlined words. 



Menus

Use the information in this section to learn how to use the options on the QuickVerse Menu Bar and Icon 
Bar located at the top of the QuickVerse   window  . The menu bar at the top of the QuickVerse window 
offers the selections shown. To open a menu and view its items, click and drag on an option, or use the 
menu's pickletter. For many menu options, there is also an icon bar button which you can use to perform 
the same function. Use the method most convenient for you.

File--Open, close, or create a file to which you can add verses in ASCII format. After adding 
verses to a file, you can then open the file in a word processing program. You can also print 
individual or groups of verses by selecting Print from the File menu.

Edit--Use standard editing commands to cut, copy, and paste text. 

Browse--Browse through the Bible's text by verse, chapter, or book. Also, insert bookmarks or go 
quickly to the verses of your choice.

Search--Search the Bible using a variety of options. You can also access Parsons Technology's 
PC Bible Atlas, Holman Bible Dictionary, Bible Illustrator for Windows, or QuickVerse 
Library if you've purchased and installed these (or compatible) programs.

Notes--Attach your own comments to any book, chapter, verse, or word in the Bible.

IndexCreate a topical index of related verses.

Fonts--Choose a font to use for the text in the Bible window, in your notes, and text that you print. 
You can also designate the color of text for the words of Christ and verse references.

Options--Designate various program settings, including display options, translation options, word 
processor settings, and desktop details. 

Windows--Open, close, and arrange windows to access the one you need. You can also access 
the dictionary for a concordance such as Strong's or the NASC. 

Help--Access online help topics to assist you with using the program.

See also:
Bible Illustrator for Windows 
Icon Bar
Pop-up Menus



Basic Information

 Welcome to QuickVerse for Windows! If you're a new QuickVerse user, you'll soon find that using the 
program can add a whole new dimension to your reading of the Scriptures, and we think you'll soon 
discover a new level of enjoyment of the Bible. If you've used QuickVerse before, you'll enjoy the 
enhancements and additions to this powerful new version of QuickVerse for Windows.

This program offers something for everyone. Children and adults alike can learn to use it quickly and 
effectively. QuickVerse's mouse compatibility can make the program easy for school-age children to use, 
encouraging them read the Bible or find their favorite Sunday School memory verses while they have fun 
using the computer at the same time. Adults can delve deeper into the Scriptures using QuickVerse's fast 
and powerful searching and indexing functions. Whatever your needs, whatever your age, the 
QuickVerse Bible package can be of value to you. If you've never worked with the Bible on a computer, 
don't worry--the ease of the Microsoft Windows interface will have you navigating the program in no time.

This section of the online help system contains general information to help you use QuickVerse for 
Windows. Click on a topic below for help getting started:

Opening a Translation
Using a Mouse 
Operating Buttons 
Screen Elements 
Data Entry Procedures 
Using Shortcut Keys 
Using the Icon Bar 
Exiting the Program 
New   QuickVerse   Features  
Product Registration 
Getting Technical Support
Ideas for Using   QuickVerse   
Add-on Products for   QuickVerse  
Readme File 



Searching

 Searching for words and passages is easy with QuickVerse. You can search the entire Bible, particular 
books and chapters, or a previously created index. This section provides you with information that will 
show you the powerful search capabilities in QuickVerse.

QuickVerse gives you two methods for searching: 

* Use the Search item in the Search menu or click the  button on the icon bar to open the 
Search window in which you can specify complete search details.

* Choose Quick Search from the Search menu or click the  button on the icon bar to find all 
occurrences of a highlighted word or phrase in the Bible window. 

When QuickVerse completes a search, it will list the verses matching your criteria. For example, if you 
search for a phrase in only Matthew through Revelation, QuickVerse won't list any verses from the Old 
Testament. 

For more details on searching, see:
Performing a Search 
The Search Dialog Box 
Phrase Searches 
Combining Fields to Narrow Searches 
Viewing Search Verses 
Search Tips
Boolean Operators
Wild Card Searches 
Complex Search Examples 
Reference Searches
Returning to the Previous Search 
Copying Search Verses 
Nave's   Topic Searches   
Using the Word List 
Using the Book List 



Using Notes

The Notes feature allows you to add comments to the Bible text, just as you probably write comments in 
the margin of your printed Bible next to particular verses and passages. You can attach notes to a single 
word or an entire verse, chapter, or book. Before adding notes, you must first open a note file. A note file 
stores all your notes for a translation. You can create one note file to store all your notes, or create a 
separate note file for each topic you address.

See these topics for further instructions on using Notes:

Creating and Opening Note Files 
Attaching a Note 
Using Existing Notes 
Creating Cross References 
Formatting Notes 
Using Book and Chapter Notes
Modifying Notes 
Read Only Notes 
Optimizing Note Files 
Printing Notes 
Using the KJV Word Study
Using the NASB Word Study 
Closing Notes



Browsing

Once you have opened a Bible translation, you can maximize the Bible window so it fills the whole 
desktop. Click the Maximize button in the upper right corner of the Bible window to enlarge the window. 
Click the Restore button to return the window to its previous size. 

The Bible window contains the translation you selected, beginning with Gen 1:1. The default display mode 
lists the book, chapter and verse for the first verse in each book. The chapter and verse are listed at the 
beginning of each chapter, and only the verse number is listed for each subsequent verse in a chapter. 
The title bar of the Bible window always provides the book and chapter number for your location in the 
text. Change the display mode using the instructions in the Display Options topic.

Use your cursor keys or the scroll bar to scroll through verses. Italics indicate words added by the 
translator. In the New Testament, you'll see red text. This signifies the words of Jesus. You can change 
the way text is displayed using the Options and Fonts menus. 

You can also use the Browse functions in QuickVerse to move quickly through the Bible to find the book, 
chapter, and verses you want to review. QuickVerse allows you to move to the previous or next book, 
verse, or chapter in the Bible, set bookmarks, go directly to the verse you select, and view a list of verses 
you've accessed in your Bible study. 

On the scroll bar, you can click or hold the up and down arrows to scroll one line at a time. Click above or 
below the elevator box to move up or down one page at a time. Drag the elevator box to move quickly to 
another place in the Bible, watching the status bar for an indication of where the elevator bar will take you 
when you release it.

On the keyboard, use the up and down arrow keys to move one line at a time, and the PgUp and PgDn 
keys to move one page at a time. The Home key will take you to Gen 1:1 and the End key will take you to 
Rev 22:21. 

You can also choose from these Browse menu options to maneuver through the Bible's text:

Go To Verse 
Bookmarks 
Previous or Next Verse 
Previous or Next Chapter 
Previous or Next Book 
Reference Trail 
Previous Reference 



Indexing

 QuickVerse's indexing feature allows you to create your own topical indexes for storing related verses. 
The topical index is simply a list of verse references that can be recalled by QuickVerse. The verses can 
be searched, viewed, copied to the clipboard, placed in a text file, or printed. The size of an index or the 
number you create is limited only by the amount of disk space available. 

Because verses in an index are not tied to a specific translation, you can save verses from different 
translations together in an index. When you print the verses in an index, they print based on the 
translation in the active window. This is also true if you copy the verses from the index to a text file or the 
clipboard. Indexes provide a useful tool for saving search results and printing all matching verses for 
various translations.

See also:
Opening a New or Existing Index 
Adding Verses to an Index 
Viewing Verses in an Index 
Editing an Index 
Duplicating and Merging Indexes 
Closing an Index 
Searching with an Index 
Complex Index Searches 



Options

 
This section introduces you to the options you have for setting up QuickVerse to suit your preferences. 
Using QuickVerse Options, you can 

*    Apply text attributes such as boldface, italics, and underlining.

*    Change the directories for your text, index, and note files.

*    Specify directories for additional QuickVerse translations.

*    Arrange, save, and restore the desktop.

*    Set other important options.

For more information, see:
Display Options 
Directories 
Translations 
Arranging the Desktop 
Font and Color Selection 
Using Other Applications with   QuickVerse   



Using Nave's Topical Bible

 Nave's Topical Bible is similar to a QuickVerse index file. Arranged as an alphabetical outline, each 
topic and subtopic is like a mini-index with related verses from throughout the Bible. Searching Nave's is 
often more extensive and complete than searching for a word or phrase. For example, if you perform a 
word search for marriage, the search turns up only 19 verses. However, if you search for the Nave's Topic 
marriage, you find 369 verses on the topic, because the concept is discussed using words other than 
marriage. In addition, you can use Nave's in these ways:

To perform complex searches. Used in combination with the Phrase and Reference fields, 
Nave's provides a more extensive, comprehensive search.

As a source of sermon outlines. Browse through Nave's topics and subtopics. Because Nave's 
is organized in outline form, it is an indispensable source for creating sermon or lesson outlines.

As a Bible dictionary. Refer to Nave's if you find an unfamiliar word or phrase in the Bible. The 
descriptive text on each topic and subtopic often provides enough information to define the word.

For character studies. Most major Bible characters have detailed outlines of their lives 
presented as subtopics under their names.

For more information on using Nave's, see:
Accessing   Nave's   
Searching with   Nave's   
Creating New   Nave's   Topics and Subtopics   
Modifying Topics and Subtopics 
Deleting Topics and Subtopics 
Copying   Nave's   Topics   



Using Files

 QuickVerse's text file capability allows you to save verses in a text file for use with other programs, such 
as a word processor. A text file is similar to an index file: you can create new files; open and close existing 
files; and assign verses, a passage, or verses in a search list to files and notes. You can also transfer all 
verses from an open index to the file. Unlike an index, however, a text file is in a format compatible with 
word processors. It is external to QuickVerse and cannot be used in a search, nor can it be manipulated 
inside QuickVerse.

For more information, see
Opening and Creating Files 
Setting File Options 
Saving Verses to Files 
Closing Files



New QuickVerse Features

 
These are some of the features you'll enjoy in this new version of QuickVerse for Windows: 

View, copy, and print the graphics in QuickVerse add-on Study Bibles. Each of the maps, 
charts, and pictures is a bitmap that you can copy to another graphics program, then print.

Use powerful Boolean search technology. QuickVerse supports a number of Boolean 
operators which allow you to define highly specific search criteria. Search the Bible for any text 
you need, from a single word to a complex phrase. With Nave's Topical Bible, you can search 
for abstract subjects as well as literal words. Additionally, QuickVerse now allows you to access 
the results from a previous search you've performed.

Write and format notes. Add your comments to the text and format them with bold, italics, and 
underlining for emphasis and clarity. You can also choose the font for the display of notes on your 
screen and that you print. QuickVerse stores notes along with the Bible text so they're always 
available at the click of your mouse.

Create cross references. QuickVerse automatically recognizes verse references typed into the 
Note window and creates a cross reference "hyperlink" that you can double-click on to jump to 
the cited passage. 

Use even more setup and display options. QuickVerse provides you with even more ways to 
format verses that you print, file, and paste. You can also choose from a variety of screen display 
options, so you can decide things such as whether you want to view complete or shortened 
references with each verse and decide what color you'd like to use for verse references. 

Copy Formatted. This new option on the Edit menu, when used in conjunction with the options 
you specify in the Clipboard Setup dialog, allows you to copy a completely formatted verse to the 
clipboard; the verse is then ready for you to paste into your word processor for use in other 
documents. 

Interface to PC Bible Atlas, Holman Bible Dictionary, The QuickVerse Library, and Bible 
Illustrator for Windows. Switch to these programs with the click of your mouse. 

Other QuickVerse highlights include:

Indexes. Search for a subject and save the verse references in a custom index. Make copies of 
the original index and refine them to cover specialized subtopics.

Multiple translations. QuickVerse provides several versions of the Bible as add-on modules. 
Compare them side-by-side in parallel windows. Scroll through the New Testament in one window 
while the other remains on a verse in the Old Testament. If you want to compare translations, 
synchronize them so they scroll together and focus on the same verse. 

Using a Concordance with QuickVerse. Add an optional module such as Strong's 
Concordance or the New American Standard Exhaustive Concordance to study the Bible in a 
transliterated Hebrew and Greek format. You can use this add-on as your guide to the Scriptures 
in their original languages. Click on a transliterated word in Hebrew or Greek to see the English 
equivalent and definition from QuickVerse.

Nave's Topical Bible. This option gives you topics in the Bible arranged in an alphabetical 



outline. Each topic is associated with various verses from the Bible. Use Nave's to locate 
concepts as well as literal terms. 

Support for word processors. As you collect Bible verses, make notes, and construct indexes, 
you'll probably want to print them or incorporate them in other documents. QuickVerse makes it 
easy for you to bring your work into any word processor.



Product Registration

If you purchased QuickVerse directly from Parsons Technology, you are automatically a registered user. 
If you purchased your copy from a retail store, complete and return the enclosed registration card. When 
you register your copy, you become eligible for free technical support, product update notices, and new 
product announcements.

See also:
Getting Technical Support



Getting Technical Support

Parsons Technology offers phone support that is best used for getting you up and running. In-depth and 
on-going support is mainly and best provided via CompuServe and other online services, as discussed 
below. 

CompuServe Information Service--the best way to get help
Type GO PARSONS at any CompuServe menu prompt. Select the forum and complete the problem 
report found in the Miscellaneous Info. library (file name:SYSPRO.TXT). We do our best to respond within 
24 hours in the forum only. You also can use our library of application bulletins and other information 
releases and interact with experts and other users. 

GEnie--one-day response
Parsons Technology is located in the IBM RoundTable, category 31, and in Software Library Section 10. 
Leave messages in Category 31 under topics for each of our products. Questions are answered within 
about 24 hours.

Telephone
Call Technical Support's voice number at 1-319-395-7314. an automated attendant will direct you to the 
right location and give Technical Support department hours. We'll take all the time needed to answer your 
questions, but you may have to wait a short time while we offer this same attention to other callers ahead 
of you.

SmartFax--for even more information
Technical bulletins, product descriptions, and other information on the most commonly asked questions 
can be sent directly to your FAX machine 24 hours a day. The Smart Fax number is 1-319-395-0176. The 
system asks which document you want. Choose 100 for instructions for using the system and a partial 
directory of available information. Choose 101 for a complete directory. You must call from a FAX 
machine. 

See also:
Information on Ordering
Help Menu 
README File 



Help Menu

 
QuickVerse provides extensive online help at any point in your work. The Help menu provides three help 
options:

* Online Help. The text you're viewing now is part of a complete online help system that provides 
topical information, including facts about new features not documented in the User's Guide, to 
help you operate QuickVerse.

* Using Help. Provides information on how to use the QuickVerse Help system.

* About QuickVerse. Contains QuickVerse copyright and version information, development team 
credits, an indication of the percentage of free system resources, and statistics regarding the file 
resources used by QuickVerse for Windows.

You can access the help system in three ways: 

* Click on the Help icon  in the icon bar.
* Press F1. 
* Select Online Help from the Help menu.

Help also appears as a button in many dialog boxes. Click on the button to obtain specific information 
about the dialog box. For information about using Windows online help, refer to the section on Help in 
your Microsoft Windows manual.

See also:
Technical Support 



Pop-up Menu

A menu that is displayed by clicking the right mouse button in a 
designated area of the QuickVerse screen. The menu contains commonly 
used options, so you can access them easily.



Ideas for Using QuickVerse

Use these sample scenarios to give yourself some ideas for how you can put QuickVerse to use. 

I'm researching word origins in the Bible. Can QuickVerse simplify my research?
If you've purchased and installed the Strong's Concordance for use in conjunction with the King 
James Version, you can easily perform a word origin study using the KJV Word Study option from 
the Notes menu in QuickVerse. If you prefer working with the New American Standard 
translation, you can purchase a concordance specifically for it. 

This week's sermon was on tithing, and now I'm interested in learning more about what the Bible 
says about that subject.

Use the Search menu to find verses that meet criteria you define. For instance, you might search 
for tith* (to find tithe, tithes, tithing, etc.) or words such as giving, offering, etc., to find verses 
related to tithing. Nave's Topical Bible is also useful for locating verses on a particular subject. 

How can QuickVerse help me research tribes and peoples of the Old Testament?
Using the powerful wild card searches will allow you to search for parts of words. Assuming that 
many tribes and peoples are referred to using a word ending in -ite (Canaanite, Israelite, etc.), 
you could use a wild card search entry such as *ite*. You could also specify a limit to tell 
QuickVerse to search only the Old Testament. 

My religion professor has assigned an essay on a Bible topic of my choice, but I have no idea 
what to write about. 

If you select Search from the Search menu to open the Search window, and then execute the 
Word List button, you can open the QuickVerse Word List. The dialog that opens displays an 
alphabetical listing of every word mentioned in the Bible and the number of times each word 
occurs. You could browse this list to get ideas, or if you have purchased and installed Nave's 
Topical Bible, you can browse its topics and use any of those in a search. 

I've found a group of verses in a search, but I don't want to type them into my word processor to 
use them.

Simply use the Edit menu options to copy the text to the clipboard; then, open your word 
processor in Windows and paste the verses using the word processor's paste command. 

As the director of our children's Christmas program, I need to give each child a verse from Luke's 
account of the birth of Jesus. I don't have time to type them all.

Start a search and type the passage into the Reference field of the Search dialog. Complete the 
search and click on the Copy to... button in the dialog that opens. Then click on the All items and 
the Printer buttons and execute OK to send all verses found in the search to the printer. 

I just started using QuickVerse, but I have to keep referring to my study Bible that has all my notes 
and thoughts in the margins.

Using the QuickVerse Notes menu, you'll soon have QuickVerse as "marked up" as your trusty 
study Bible. You can attach your thoughts, comments, and study notes to any book, chapter, 
verse, or word in the Bible using the Notes menu features.

I want to compare the Gospel accounts of the birth of Jesus, but flipping back and forth between 
pages in my Bible is so cumbersome.

With QuickVerse, you can have several Bible windows open at a time and set them to scroll 
individually or synchronously using the Windows menu. This will allow you to look at different 
sections of the Bible simultaneously on your screen, making study topics such as the different 



accounts of the Christmas story convenient.

See also:
QuickVerse   Add-on Products   



Add-on Products for QuickVerse

 Using one or more of the QuickVerse add-on modules can expand the ways you can use QuickVerse 
and give you even greater power and flexibility in your study of the Bible. Following is a list of add-on 
products that are currently available. (Additional modules are released on a regular basis. Contact 
Parsons Technology for up-to-date information.) See Ordering Information for details on purchasing any of 
these modules directly from Parsons Technology, or look for these products in your local Christian 
bookstore.

King James Version (KJV)

New King James Version (NKJV)

New International Version (NIV)

New American Standard Bible (NASB)

Revised Standard Version (RSV)

New Revised Standard Version (NRSV)

New Century Version (NCV)

The Living Bible (TLB)

American Standard Version (1901) (ASV)

New American Standard Bible 1995 Update (NNAS)

Strong's Concordance with Hebrew and Greek Dictionaries

Nave's Topical Bible

New Scofield Study Bible (Notes, used with any translation)

The Believer's Study Bible (Notes, used with any translation)

Treasury of Scripture Knowledge (contains over 500,000 cross references)

New American Standard Exhaustive Concordance (NASC) and Dictionary

Ryrie Study Bible (Notes, used with any translation)

Additionally, the following programs are available for use with QuickVerse:

PC Bible Atlas for Windows 

Holman Bible Dictionary 

The QuickVerse Library

Bible Illustrator for Windows

Word for the Day 

For more information, see:
Using an Atlas with   QuickVerse   
Using a Bible Dictionary with   QuickVerse   
Using   The QuickVerse Library   with   QuickVerse  
Using   Bible Illustrator   with   QuickVerse   
Using   Nave's Topical Bible   



Using a Concordance 
Using Study Bibles 



Opening a Translation

 
Use the Open Bible dialog box to choose the Bible translation you would like to use. The Open Bible 
dialog box will appear when you do any of the following:

* Start QuickVerse for the first time.

* Choose Open Bible from the Windows menu.

* Click the  button on the icon bar.

When the Open Bible dialog appears, click on a translation in the list along the left side of the Open Bible 
dialog box. Note that you may only open a translation that you have installed. (See QuickVerse   Add-on   
Modules for information on the translations and other products available for use with QuickVerse.)

In the Open Bible dialog you may also select a Note file to open with the translation. If you have not yet 
created any note files, you will not be able to open them at this point. (See Creating and Opening Note 
Files for instructions on creating note files.) 

If you have created a note file in QuickVerse and would like to open it from within the Open Bible dialog, 
follow these steps:

1. Make sure the extension of the note file (*.NOT by default) appears in the the Note File field in the 
Open Bible dialog. 

2. Check to see that the directory path displayed is the location in which you saved the note file. 

3. If you need to change the directory, double click on the appropriate items in the Directories list 
box. (Double click on the [..] item to access the directory one level above the current 
subdirectory.)

4. Once you establish the correct path to the location of your note file, click once on the Note file in 
the Files list box. Its name will appear in the Note File field. 

When you've selected the translation and note file you'd like to use, click on the OK button at the bottom 
of the dialog. The items you selected will open in a new Bible window on your screen. 

NOTE:    If the note file you selected is not able to be used with the translation you 
selected, QuickVerse will display a warning message. You can either select a different 
note file that was created for use with the translation you selected, or you can select the 
translation that corresponds to the note file you've selected. 

See also:
Opening Multiple Translations 
Viewing the Bible Window 
Closing a Bible Window 
Using Note Files



Transferring Verses to a Word Processor

QuickVerse has four easy ways to transfer verses to a word processor:

Copy and Paste. When you copy text, QuickVerse places it in your Windows clipboard. From 
the clipboard, you can paste the text into a document in a word processing program.

Word Processor Customization. This feature lets you directly access QuickVerse from within 
certain word processors (and other applications) without ever leaving the program. (This method 
is not compatible with all word processors. DDE is the preferred method.)

DDE. If your word processor supports Dynamic Data Exchange (DDE), you can use DDE to 
transfer verses to your word processor. 

Text files. Another way to transfer verses is to create a text file and import it into your word 
processor. 

See also:
Transferring Verses to a Windows Word Processor 
Transferring Verses to a DOS Word Processor 



Menu Bar

A horizontal list of menu options located across the top of the QuickVerse 
Window, just under the program title. Each item in this menu bar has a 
pull-down menu from which you select QuickVerse operations.



Icon Bar

A row of icons below the menu bar at the top of the QuickVerse window. 
Each icon is a graphic representation of a frequently used option. You can 
click on an icon with your left mouse button to perform an action rather 
than accessing the option through the menus.



Icon Bar

You can access the most-used functions of QuickVerse through the icons on the icon bar located across 
the top of the QuickVerse screen. For example, clicking on the first icon in the icon bar (the Open Bible 
icon) opens the translation of your choice. You can click on the icons for common tasks instead of using 
the menu. Hide or display the icon bar by choosing Icon Bar from the Options menu. When the icon bar is 
displayed, a check mark will appear next to the item on the menu.

The icon bar buttons are described below:

Open Bible Opens a new window containing a Bible translation of your choice.

Tile Displays the open translations side by side.

Cascade Displays the translations as full windows, placing them one behind the other.

Search Searches for verses according to word, phrase, reference, or other criteria you specify.

Quick Search Searches for the word or phrase you highlighted in the Bible text or Note window.

List Occurrences Displays a Search List after you perform a search.

Previous VerseMoves to the previous verse in the list of verses produced by a search.

Next Verse Moves to the next verse in your search.

PC Bible Atlas Opens the PC Bible Atlas program if you've purchased and installed this (or a 
compatible) program.

QuickVerse Library Opens The QuickVerse Library if you've purchased and installed this 
(or a compatible) program.

Dictionary Lookup Opens the Holman Bible Dictionary if you've purchased and installed it.

Go to Verse Moves directly to a verse you specify.

Bookmarks Lets you set new bookmarks or move to existing ones. Bookmarks in 
QuickVerse mark favorite or most-referenced verses.

Previous Reference Returns you to your previous verse reference location in the text. 

Help Lets you directly access QuickVerse's online help.
See also:
Help menu
Menu Bar 



Pop-up Menus

 In addition to the menus on the Menu Bar, you can access two pop-up menus using your right mouse 
button. The menu that pops up when you click will vary depending on the location of your mouse: 

* If you press the right mouse button when have your mouse placed in an active Bible window 
(active windows are indicated by a colored title bar), the pop-up menu that appears will contain 
these options:

* Quick Search
* Previous Searches
* PC Bible Atlas
* Dictionary
* Bible Illustrator
* Add Verse to Index
* Add Verse to File
* Print Verse
* Copy
* Copy Formatted.

* If you press the right mouse button with your mouse placed in an active Note window (indicated 
by a colored title bar), the menu that pops up will contain these options: 

* Save Note
* Cut
* Copy
* Paste
* Delete
* Select All
* Bold
* Italic
* Underline.

See also:
Using Notes 
Quick Search 
Using   PC Bible Atlas   with   QuickVerse   
Using Indexes 
Using Files 
Printing 
Copying Verses 
Formatting Options 



Note Window

When a note file is open, this window will appear in the lower portion of 
your screen. It contains the text of your notes. It is active when its title bar 
appears in color. Activate it by clicking in the Note window or by 
choosing Write Note from the Notes menu.



Bible Window

This window contains the Bible's text. You may have several Bible 
windows open at once if you've opened multiple translations, or if you're 
comparing different passages in the same translation. A window is active 
when its title bar appears in color. Activate it by clicking anywhere in the 
window.



QuickVerse Window

The QuickVerse window is the window that holds all the elements you use to work with the program. 
Bible windows, Note windows, and dialog boxes all appear within the QuickVerse window. 

See also:
Menu Bar 
Icon Bar 
Screen Elements 
Using Buttons



Performing a Search

Use these steps to perform a basic search. Choose from the topics at the end of these steps for 
information on performing complex searches using the sophisticated search technology in QuickVerse.

To perform a simple search:

1. Click the Search icon  or choose Search from the Search menu to display the 
Search dialog box.

2. Type a word or phrase in the Phrase field. Use upper or lower case letters--QuickVerse searches 
for the words or phrases regardless of capitalization unless you mark the Perform a case-
sensitive search check box. With your cursor in the Phrase field, you can click the Word List 
button to display the Word List. This list contains all words in the translation you are searching. 

You can narrow your search using the Reference, Index, or Nave's fields. The Reference field 
determines the book(s), chapter(s), and/or verse(s) in the Bible you want to search. To use the 
Index field, you must first create an index. The Nave's field lets you access the Nave's Topical 
Bible--a topical index of the Bible. 

3. Notice the Reference Shortcuts on the screen. These let you limit your search. For now, select 
the New Testament or type Mat-Rev in the Reference field. You do not have to type the entire 
name of a book in the Reference field. Just type the first few letters of the name of each book--
enough to distinguish it from other books.

4. Click the Search button. QuickVerse searches through the designated books of the Bible (in this 
case, Matthew through Revelation), moves the current verse marker to the first verse containing 
the word(s) you typed, and displays a Search List of all verses containing the word(s). It also 
displays the number of times the word or phrase occurs and the number of verses in which it 
occurs.

5. QuickVerse automatically moves the current verse marker in the active Bible window to the first 
matching verse. To see other verses that match, highlight a verse and click View, or double-click 
on the verse. The program moves to that verse in the translation and marks it. Click Close to 
close the Search List dialog or move it out of the way with your mouse to view the verse. You can 
configure QuickVerse to close the Search List dialog automatically after you select a verse. See 
Display Options for more information.

6. To view other verses in the Search List, choose from the following:

* Click the Previous Verse  and Next Verse 

 icons.
* Choose Previous Verse and Next Verse on the Search menu.

* If the Search List is closed, click the Search List icon  or select List Occurrences from the 
Search menu to display the list of verses again. Highlight a verse and click View.

See also:
Boolean Searches 
Reference Searches 



Search Tips 
The Search Dialog Box 
Phrase Searches 
Combining Fields to Narrow Searches 
Viewing Search Verses 
Search Tips
Wild Card Searches 
Complex Search Examples 
Returning to a Previous Search 
Copying Search Verses 
Nave's   Topic Searches   



Creating and Opening Note Files

You can create many note files for a single translation, or you may choose to include all your comments in 
one large note file. For instance, if you study the topic of marriage, you could create a separate note file 
for it. You could also put your comments on all your Bible studies into one note file. Choose the method 
that suits your needs. 

To use notes:

1. Select Open Notes from the Notes menu.

2. QuickVerse asks for a file name. Type MARRIAGE (or another name you would like to use for 
your note file) in the Note File field. File names consist of eight or fewer characters for the name, 
a period, and a three-character extension. By default, QuickVerse gives note files the 
extension .NOT if you don't type one. The program looks for this extension when you access your 
notes.

3. Click OK. The program displays a message asking if you would like to create the new note file. 
Click Yes. 

4. QuickVerse displays the New Notes dialog asking for a description of the note file. This can help 
you distinguish one note file from another. Type a brief description in the Description field. 

5. Choose the translation for the note file. 

6. Click OK and a note window appears at the bottom of your active window with the file name in the 
title bar.

The cursor appears as a hand in the Bible window, allowing you to highlight whole words. When 
you move the cursor to the Note window, it appears as an I-beam, just as in a word processor.

See also:
Attaching Notes 
Closing Notes 
Read Only Notes 
Formatting Notes 
Optimizing Note Files 
Using Book and Chapter Notes 



Book and Chapter Notes

QuickVerse allows you to attach your own comments to books and chapters in the Bible using the Book 
Note and Chapter Note options in the Notes menu. Book and chapter notes have the same cross 
referencing capabilities that verse and word notes have, so references you enter will be marked as cross 
references. 

To use book and chapter notes:

1. Open a note file in the Bible window. (Choose Open Notes from the Notes menu to open a note 
file.) 

2. Click your mouse anywhere in the book or chapter for which you want to write a note.

3. Select Book Note from the Notes menu. The Bible window will display the first verse in the current 
book. (Selecting Chapter Note will display the first verse in the current chapter.) 

4. After selecting the option you want from the Notes menu, type your note in the Note window. 

5. Once you have entered your note, you can return to the regular verse note mode by selecting 
Book Note (or Chapter Note ) again from the Notes menu. You'll see that a check mark appears 
next to the option you had been using, and selecting the option again toggles it off. The Note 
window will then display the verse notes rather than the book or chapter note. You may also 
simply click your mouse in the Bible window to return to the verse note display mode. 

To access a book or chapter note you have written, first be sure a note file is open. Then position the 
verse marker anywhere in the appropriate book or chapter and select Book Note or Chapter Note from 
the Notes menu. The Note window will display the note you entered for that book or chapter.

If a book note is present for a book, then a symbol similar to a superscript 'o' is added to the first verse in 
the book. If a chapter note is present for a chapter, then a symbol similar to a superscript 'a' is added to 
the first verse in the book. These tags help you to locate books and chapters that contain notes as you 
browse through the Bible text.

Book and chapter notes can be automatically included with verses you copy, file, or print. A book note is 
included with the first verse in the book. A chapter note is included with the first verse in the chapter.

See also:
Closing Notes 
Read Only Notes 
Formatting Notes 
Optimizing Note Files 
Printing Verses 
Filing Verses 
Copying Verses 



Go To Verse

Use Go To Verse to move immediately to a specific verse in the Bible. To use this feature:

1. Click  on the icon bar or select Go To Verse from the Browse menu. The Go to Verse dialog 
box will open.

2. Scroll through the Book, Chapter, and Verse lists to find your verse. Or, type the verse in the Go 
To field. For example, to find Ephesians 5:28, scroll through the book list until you find Ephesians. Click 
on the name to highlight it. Then highlight chapter 5 by clicking on it with your mouse. Next scroll through 
the verse list until you find 28 and highlight it. Notice that the verse reference you select also appears in 
the Go To field.

3. Click the OK button . 

The Go To Verse dialog will close and the verse you specified will be located. It is displayed as the current 
verse in the Bible window. 

See also:
Going to the Previous Reference 
Viewing the Reference Trail 
Bookmarks 



Bookmarks

 If you use your Bible frequently, you probably have marked your favorite or most-referenced verses. 
Perhaps you like to mark the page where you stop reading so you can pick up there again. The 
QuickVerse Bookmarks feature does that for you.

You can place up to ten bookmarks. Once you place a bookmark, QuickVerse stores it for future 
reference. You can change these bookmarks at any time. The Bookmarks feature appears both as an 
icon, , and as an option under the Browse menu. 

For more information, see:
Setting Bookmarks 
Going to a Bookmark



Previous or Next Verse

To move to the next verse or to the previous one, select either Next Verse or Previous Verse in the 
Browse menu.



Previous or Next Chapter

To move to the next chapter or to the previous one, select either Next Chapter or Previous Chapter in the 
Browse menu. The program will take you to the first verse of the next or previous chapter.

NOTE:    If you are not already viewing the first verse in a chapter, QuickVerse will take 
you to that verse when you choose Previous Chapter. For example, if you are in John 
3:16, previous chapter returns to John 3:1, not John 2:1.



Previous or Next Book

To move to the next book or to the previous one, select either Next Book or Previous Book in the Browse 
menu. The program will take you to chapter 1, verse 1 of the next or previous book.

NOTE: If you are not already viewing the first verse in a book, QuickVerse will take you 
to that verse. For example, the previous book to Mark 1:1 is Matthew 1:1, but the 
previous book to Mark 2:1 is Mark 1:1.



Reference Trail

The Reference Trail keeps track of some of the previous verses that you've seen. You'll usually find it 
most convenient to return to a previous reference with the Previous Reference icon; however, there may 
be times when you'd like to jump back several references at once. The Reference Trail window provides 
this capability. 

To use the Reference Trail, select Reference Trail from the Browse menu and double-click on the verse 
reference you wish to return to. When you click on an item, QuickVerse will take you to that verse in the 
Bible text and update the Reference Trail. 

When you return to a verse, the Reference Trail is updated to reflect your choice. The verse you selected 
and any verses that occurred after it in the viewing order are removed from the Reference Trail. 

If you think of the Reference Trail as having a tree-like structure, references in the list are branches off of 
the verse that preceded it. Therefore, when you click on a verse in the Reference Trail that has any 
"branches," the verse you're returning to, as well as any of its branches will be removed from the list. 

For example, in the Reference Trail pictured below, if you click on 1 Chr 2:26, QuickVerse will return you 
to that verse and remove 1 Chr 2:26, Ezra 2:61, Est 5:10, and Psa 128:3 from the Reference Trail. 

See also:
Reference Trail Example 
Cross References 
Bookmarks





Previous Reference

The Previous Reference feature, available from the Browse menu or by clicking  on the icon bar, allows 
you to return to your previous location in the Bible's text. This is especially useful when browsing the Bible 
or following cross references in your notes. 
For instance, if you've just jumped to a bookmarked verse, simply click on the Previous Reference icon  
or select Previous Reference from the Browse menu to return to your previous location in the text. Or, if 
you were studying the book of John and saw that a note containing cross references was attached to the 
word believe in John 3:16, you might want to click on one of those cross references to view the cited 
verse. Once you read the verse, click on the Previous Reference icon (or use the Browse menu option) to 
return to John 3:16. You can then click on any other cross references contained in the notes attached to 
that verse, or continue with your study of John.

QuickVerse maintains a list of your previous verses. This list is called the Reference Trail. When you 
select Previous Reference, or click the Previous Reference icon, QuickVerse returns to the top item in 
the list, and then removes that item (you can view the contents of the list by selecting Reference Trail 
from the Browse menu). A verse is added to the Reference Trail when you:

*    View a search verse

*    Use Go To verse

*    Go to a bookmarked verse

*    Follow a cross reference

(Note, however, that verses are not added to the Reference Trail when you browse using your arrow 
keys, mouse, or scroll bar.)

The verse that you left, not the verse that you are going to, is added to the list, since the verse you're 
leaving is the verse that you'll likely want to return to. 

See also:
Attaching Notes 



Current Verse

The current verse is marked by a > in the Bible window. The current verse 
marker is important to note when you are performing QuickVerse 
functions such as filing and printing. You may move the marker to 
different areas of the text using your arrow keys or options on the Browse 
menu.



Scroll Bar

A vertical scroll bar along the right edge of an open window lets you 
quickly move up and down throughout the verses of the Bible. Click the 
arrow buttons on the bar to scroll one line at a time; click and hold one of 
the arrows to scroll continuously.

The box within the scroll bar is an elevator. Moving the elevator lets you 
browse through the text in larger sections. Click above or below the 
elevator to jump shorter distances.



Setting Bookmarks

QuickVerse bookmarks are a handy way to mark a place in the text that you might want to return to at a 
later time. 

To set a bookmark:

1. Click once on the Bookmarks icon  to display the Bookmarks dialog. If you haven't placed any 
bookmarks before, you'll notice that each one is set at Genesis 1:1.

2. Click on the first bookmark button. 
3. Click Set. The Set Bookmark dialog appears. Scroll through the books, chapters, and verses to 
select a reference. The program defaults to the current verse in the translation.
4. Once you've selected a verse, click OK. QuickVerse sets the bookmark and adds the reference 
to the Bookmarks window.

5. Click View to go to the selected bookmark. Or, click Close to close the Bookmarks dialog and 
return to where you left off in the Bible.

You can set up to ten bookmarks, and you may change them at any time if you wish. 

See also:
Going to a Bookmarked Verse 



Going to a Bookmark

As you prepare your Bible study, it is easy to jump to the Bible verses where you have set bookmarks. To 
use a bookmark:

1. Click the Bookmarks icon . All bookmarks you've set appear.

2. Click the button next to the bookmark you want to use.
3. Click the View button. QuickVerse takes you to that verse.
QuickVerse also provides shortcut keys to move to bookmarks. Press Ctrl and the number of the 
bookmark to move to it. For example, press Ctrl+1 to move to the first bookmark. To set or change a 
bookmark, move the current verse marker to the verse where you want the bookmark. Press Shift+Ctrl, 
and the new number of the bookmark to set it. For example, press Shift+Ctrl+2 to set the second 
bookmark. Note that the tenth bookmark is numbered with a 0 (zero), rather than with 10. 



Shortcut Keys

QuickVerse provides shortcut keys to simplify the selection of often-used 
commands. As you become familiar with the program, you can navigate 
through the menus with these shortcut keys.

For example, press F1 at any time to view a Help screen. Other shortcut 
keys consist of the Ctrl or Shift key plus a letter key. To search for verses, 
for example, press Ctrl+S. Shortcut keys appear on the pull-down menus 
next to the applicable items.



Boolean Search Operators

QuickVerse lets you use a system of variables to search for combinations 
of words. These operators allow you to define highly specific search 
criteria.



Ordering Information

 To order Parsons Technology products, contact our Orders Department toll-free 24 hours a day at 1-800-
223-6925. Outside North America, call 1-319-395-7300. Our order line staff are eager to help you, but 
they are not trained in the mechanics of our software. Please do not call them with technical support 
questions. They cannot transfer your call to Technical Support.

Order products using online services, too. To shop using CompuServe Information Service, type GO PA. 
If you use GEnie, type PARTECH. You can also place orders using DELPHI.

See also:
Technical Support 
QuickVerse   Add-on Modules   



Note File

A QuickVerse feature that allows you to append your own comments to 
verses, words, books, and chapters in the Bible. 



KJV Word Study

 If you own both the King James and Strong's Concordance modules, you can use the KJV Word Study. 
The KJV Word Study creates a word note for each English word in the KJV that has a corresponding 
entry in Strong's Concordance and places the Hebrew or Greek definition from the Strong's 
Concordance in the note. This can be useful for doing detailed word studies. 

To use this feature, you must own both the Strong's Concordance and the King James Version Bible 
Text. To use the KJV Word Study:

1. Open a Bible window, selecting KJV as the translation. 

2. Open a new or existing note file. (The note file must be one created to use with the KJV only; that 
is, it can not be one created to use with all translations.)

3. Select a verse. The current verse marker (>) should point to it.

4. Select KJV Word Study from the Notes menu. QuickVerse automatically opens the 
Hebrew/Greek module in the background if it isn't open.

QuickVerse scans each word in the current verse and attaches a note to it. Each note displays the 
corresponding Hebrew or Greek word as well as the definition of each word in the original language. 
Some English words in the King James translation are translated into two Hebrew/Greek words. Other 
English words do not have a corresponding Hebrew or Greek word. Periods (.) in the Hebrew/Greek text 
indicate the positions of words that are not translated. See the Strong's Concordance for use with 
QuickVerse addendum included with your Strong's installation disks for complete details on operating 
this module, or refer to online help topics for Using a Concordance.

You can also perform a word study on each verse in a Search List. After performing a search, select a 
verse from the list and select KJV Word Study from the Notes menu. QuickVerse asks if you want to 
perform the word study on all verses in the list. Click Yes to select all verses. Click No to perform the word 
study on the current verse only. 

See also:
Using Notes 



NASB Word Study

 If you own both the New American Standard Bible and the New American Standard Exhaustive 
Concordance (NASC) modules, you can use the NASB Word Study. The NASB Word Study creates a 
word note for each English word in the NASB that has a corresponding entry in the NASC and places the 
Hebrew or Greek definition from the NASC in the note. This can be useful for doing detailed word studies. 

To use this feature, you must own both the NASC and the New American Standard Bible Text. To use 
the NASB Word Study:

1. Open a Bible window, selecting NASB as the translation. 

2. Open a new or existing note file. (The note file must be one created to use with the NASB only; 
that is, it can not be one created to use with all translations.)

3. Select a verse. The current verse marker (>) should point to it.

4. Select NASB Word Study from the Notes menu. QuickVerse automatically opens the NASC 
module in the background if it isn't open.

QuickVerse scans each word in the current verse and attaches a note to it. Each note displays the 
corresponding Hebrew or Greek word as well as the definition of each word in the original language. 
Some English words in the NASB translation are translated into two Hebrew or Greek words. Other 
English words do not have a corresponding Hebrew or Greek word. Periods (.) in the NASC 
Hebrew/Greek text indicate the positions of words that are not translated. See the New American 
Standard Exhaustive Concordance for use with QuickVerse addendum included with your NASC 
installation disks for complete details on operating this module, or refer to online help topics for Using a 
Concordance.

You can also perform a word study on each verse in a Search List. After performing a search, select a 
verse from the list and select NASB Word Study from the Notes menu. QuickVerse asks if you want to 
perform the word study on all verses in the list. Click Yes to select all verses. Click No to perform the word 
study on the current verse only. 

See also:
Using Notes 



Wild Card Searches

 Sometimes, you may want to search for several forms or tenses of a particular word. QuickVerse's wild 
card function can help you locate words having the same root, suffix, and/or prefix. Insert an asterisk (*) 
anywhere in the word (front, middle, or end) to perform searches such as:

bapt* Finds all occurrences of bapt ending in any letters--baptize, baptized, baptism, Baptist, 
etc.

*ites Finds all words ending in the suffix -ites--Canaanites, Hittites, Amorites, etc.

un*ful Finds all words beginning and ending with the designated prefix and suffix--unfruitful, 
unlawful, etc.

The * wild card can match zero or more characters. If you want to limit the wild card to match one and 
only one character, you can use the ? wild card character. For example Abda, Abia, and Abba would all be 
found if you searched for ab?a. Note that you may use both types of wild cards (* and ?) in the same 
search word.

The wild card feature can be combined with other words in a phrase search such as Jesus sa* to locate 
Jesus said, Jesus saith, etc. When performing wild card searches, try to supply as many letters as 
possible in order to narrow the number of words included in the search, and thus speed the location of the 
phrase being sought. 

See also:
Wild Cards and Boolean Operators 



Using PC Bible Atlas with QuickVerse

 PC Bible Atlas can be activated or searched by selecting the PC Bible Atlas item in the Search menu or 
by using the Atlas icon on the icon bar. This menu item acts differently depending upon whether or not 
any text is selected in the active window. If no text is selected, then this menu item simply activates or 
switches to PC Bible Atlas. However, if text is highlighted, selecting this menu item will not only switch to 
the atlas, it will also begin a search for the highlighted text. For instance, if you highlight the word 
Jerusalem in either the Bible text window or in a Note window in QuickVerse, selecting PC Bible Atlas 
from the Search menu will cause PC Bible Atlas to search for Jerusalem.

See also:
Using   Holman Bible Dictionary   with   QuickVerse   
Using   Bible Illustrator for Windows   with   QuickVerse   
QuickVerse   Add-on Modules   



Using Holman Bible Dictionary with QuickVerse

 The dictionary can be activated or searched by selecting the Dictionary item in the Search menu or by 

clicking on the  icon on the icon bar. This option acts differently depending on whether or not any text 
is selected in the active window. If no text is selected, then this option simply activates (or switches to) the 
dictionary. However, if text is highlighted, selecting this menu item will not only switch to the dictionary, but 
also ask it to look up the definition of the selected text. For instance, if you highlight the word Jerusalem in 
either the Bible text window or in a Note window, selecting Dictionary from the Search menu will cause 
the dictionary to search for the definition of Jerusalem.

See also:
Using   PC Bible Atlas   with   QuickVerse   
Using   Bible Illustrator for Windows   with   QuickVerse   
Using   The QuickVerse Library   with   QuickVerse  
QuickVerse   Add-on Modules   



Using The QuickVerse Library with QuickVerse

The library can be activated by selecting the QuickVerse Library item in the Search menu or by clicking 

on the  icon on the icon bar. This option acts differently depending on whether or not any text is 
selected in the active window. If no text is selected, then this option simply activates (or switches to) the 
library. However, if text is highlighted, selecting this menu item will not only switch to the library, but initiate 
a search. For instance, if you highlight the word Jerusalem in either the Bible text window or in a Note 
window, selecting QuickVerse Library from the Search menu will cause the library to search for the 
occurances of Jerusalem.

See also:
Using   PC Bible Atlas   with   QuickVerse   
Using   Bible Illustrator for Windows   with   QuickVerse   
Using Other Applications with   QuickVerse  
QuickVerse   Add-on Modules   



Opening Multiple Translations

 You can open several translation windows at a time in QuickVerse, using the same steps as you use to 
open a single translation. Viewing multiple Bible windows at once, even if they all contain the same 
translation, can be handy when you're studying the Bible. You can study and compare passages from 
different areas of the Bible with ease. The Bible window title bar  denotes the translation, for example, 
KJV-1 and KJV-2, or NIV-1 and HG-1. If you own two or more translations, you can open each to compare 
verses side by side. To open a translation:

1. Click once on the Open Bible icon  to display the Open Bible dialog box. You can 
also access this function through the Windows menu, or by pressing Ctrl+O. Choose the method 
most comfortable to you.

2. Select a translation from the Open Bible dialog and click OK. (You may also select a note file to 
open if you've previously created one.)
A new Bible window appears containing the translation you selected, beginning with Gen 1:1. Repeat 
steps 1 and 2 if you would like to open more Bible windows. Note that you can open as many translations 
as your computer's memory capacity allows.

By default, the Bible windows are organized in a cascade when you open a number of them at once. 
However, to study them more easily, you can tile the windows to align them next to one another on the 
desktop. Click the tile button  on the icon bar, or choose Tile from the Windows menu. The windows 
will be rearranged on your screen so that you can view the text in each of them. To return them to the 
cascade arrangement, click the cascade button 

 or choose Cascade from the Windows menu. In the Cascade arrangement, you can also bring a Bible 
window to the front by selecting Next Window from the Windows menu or clicking anywhere in the 
window you want to access.

Using your mouse, click first in one translation, then in the other. When you click on a translation, the title 
bar is highlighted. This indicates the active window. You can search, set bookmarks, browse, and create 
indexes only in the active window. 

See also:
Viewing the Bible Windows 
Synchronizing Multiple Windows 
Closing Translations 



Desktop

The desktop is the surface on which the elements of the program are 
displayed. Think of the menu bar, icon bar, status bar, and scroll bar as a 
border for the QuickVerse desktop.



Cascade

An arrangement that places multiple windows one behind another so that 
only the title bar for each window behind the one in front is visible.



Synchronizing Multiple Windows

As you scroll through one translation, verses in the other translation(s) you have open do not scroll. To 
synchronize both translations to make comparing verses easier, select Synchronize from the Windows 
menu. If you move to a verse in one translation, the other translation moves to the same place.

See also:
Opening Translations 



Closing a Bible Window

To close a Bible Window, make sure the window you want to close is the active window. Click anywhere 
in a window to make it active. Then select Close Bible from the Windows menu or double-click on the 
Bible window's Control-menu box. The Bible window will close. 



Transferring Verses to a Windows Word Processor

To transfer verses to a Windows word processor:

1. Start your word processor and create or open a document. (You may want to arrange your 
windows so QuickVerse is on one half the screen and your word processor on the other.)

2. Click the QuickVerse window to make it active. 

3. The next step is to select the words or verses you want to use in your Bible study. To do this, 
choose one of the following:

Copy Passage. Choose Copy Passage from the Edit menu to open the Copy Passage dialog. 
Type the references for the range of verses you want to copy, as in Mat 1:15-Mat 6:12, and select 
the desired translation. (If not already open, it opens automatically.) Click OK.

Copy. Highlight the words or verses you want. Click the mouse once to highlight a word. Click 
twice to highlight a verse. Click and drag to highlight a range of verses. Select the Edit menu and 
choose Copy. QuickVerse places the text in the Windows clipboard.

Copy Formatted. Highlight the passage you would like to copy and choose Copy Formatted from 
the Edit menu (note that when using Copy Formatted, the entire verse is copied even when only a 
portion of it is highlighted). The verse copied to the clipboard will be formatted as you specified in 
the Clipboard Setup dialog so that you can paste a completely formatted verse to your word 
processor. 

4. Click on your word processor window or press Alt+Tab to make it active.

5. Place the cursor at the point where you want to put the Bible text. 

6. Choose Paste from the Edit menu. The text is inserted.

See also:
Transferring Verses to a DOS Word Processor
Using Dynamic Data Exchange 
Word Processor Customization 



Transferring Verses to a DOS Word Processor

To transfer verses to a DOS word processor:

1. Start your word processor in a DOS session under Windows. With the word processor running, 
make sure it's in a window on the desktop. If it isn't, press Alt+Enter to put it in a window.

2. Click the QuickVerse   window   to make it active. 

3. Highlight the verses you want.

4. Select the Edit menu and choose Copy. QuickVerse places the text in the Windows clipboard.

5. Click on your word processor window to make it active. 

6. Place the cursor at the point in the document where you want the Biblical text to appear. 

7. Press the control button at the upper left hand corner of the window containing your word 
processor. Windows displays a menu of control options.

8. Select Edit. Windows displays a menu of editing options.

9. Choose Paste. Your Bible text appears in the document.



Edit Menu

The Edit menu provides all the tools you need to copy and paste completely formatted verses to your 
word processor. You can also use the Edit menu commands to edit your notes. You'll find the following 
options on the Edit menu:

Undo. Select Undo when you want to cancel the most recent editing function you performed. For 
example, if you chose Delete to remove a part of a note that you had written, you can select Undo to 
reinsert the deleted text. Important: You must choose Undo BEFORE you leave the Note window in order 
for the function to respond. The Undo option is grayed and unavailable once another action is performed, 
so if you decide to undo an edit, you must do so immediately after the edit is completed.

Cut. Select Cut from the Edit menu when you've highlighted word(s) in a Note window that you wish to 
remove or place in another Note window. To select text, click and drag the mouse over the text to highlight 
it, or if you want to highlight an entire note window entry at once, choose Select All from the Edit menu. 
When you select cut, the selected text is placed on the clipboard until you cut or copy another selection. 

Copy. Highlight the words or verses you want to copy. Click the mouse once to highlight a word. Click 
twice to highlight a verse. Click and drag to highlight a range of verses. Select Copy from the Edit menu 
and QuickVerse will place the text in the Windows clipboard.

Paste. Use Paste to place text you've cut or copied to the clipboard into a Note window. If you've placed 
text from a word processor onto the clipboard using the word processor's cut or copy commands, you can 
then select Paste from the QuickVerse Edit menu to paste that text into a note. Your cursor needs to be 
placed in a Note window and text must be present on the clipboard in order to select Paste from the Edit 
menu.

Delete. Select Delete when you want to permanently remove the selected Note text from your note. 
Selecting Delete does NOT place the text on the clipboard. 

Copy Formatted. Highlight the passage you would like to copy and choose Copy Formatted from the Edit 
menu (note that when using Copy Formatted, the entire verse is copied even when only a portion of it is 
highlighted). The verse copied to the clipboard will be formatted as you specified in the Clipboard Setup 
dialog so that you can paste a completely formatted verse to your word processor. 

Copy Passage. Choose Copy Passage from the Edit menu to open the Copy Passage dialog. Type the 
references for the range of verses you want to copy, as in Mat 1:15-Mat 6:12, and select the desired 
translation. (If not already open, it opens automatically.) Click OK. 

Clipboard Setup. Choosing this option from the Edit menu will open a Clipboard Setup dialog that 
contains a set of verse formatting options. Here you can format the display of verses you paste to a 
Windows word processor. 

See also:
Pasting to a Word Processor 
Copying Passages 
Dynamic Data Exchange 
Word Processor Customization 



Windows Menu

Options on the Windows menu allow you to work with the Bible windows on your screen. Choose from the 
following options:

Open Bible--Choose Open Bible to open a Bible translation of your choice. See Opening a 
Translation for complete details. 

Close Bible--Select Close Bible to close the active Bible window. A Bible window is active if its 
title bar appears in color. 

Close All Bibles--Use this option to close all Bible windows on your screen at once. This option 
prevents the need to close each Bible window separately.

Next Window--When you have multiple Bible windows open at once, you can move between 
them (make a new one active) by choosing Next Window. The same operation is accomplished 
by clicking your mouse anywhere in the Bible window you wish to make active.

Cascade--When you open multiple Bible windows, the translations are arranged in a cascade 
with one Bible window placed on top of another. Except for the Bible window on the top of the 
cascade, only the title bar for each window is visible in this arrangement. 

Tile--When you're working with multiple Bible windows, you'll probably be using the tile 
arrangement. This option places your open Bible windows side by side so that the Bible's text is 
visible for each.

Arrange Icons--If you minimize a Bible window using its Minimize button, an icon of the window 
is placed on the QuickVerse desktop. You can use Arrange Icons to cause QuickVerse to align 
the icons along the bottom of the QuickVerse   window  . 

Synchronize--Select Synchronize if you would like multiple Bible windows that you have open to 
scroll in unison with one another. This is helpful when comparing passages in different 
translations. This is a toggle option, so a check mark will appear next to Synchronize in the 
Windows menu when the option is active. Select it again to remove the check mark and cause 
your windows to scroll individually. 

Strong's Dictionary--If you have Strong's Concordance with Hebrew and Greek Dictionaries 
installed, you may access the Strong's Dictionary using this menu option. 

NASC Dictionary--If you have the New American Standard Exhaustive Concordance with 
Hebrew and Greek Dictionary installed, you may access the NASC Dictionary using this menu 
option. 

See also:
Opening a Translation 
Opening Multiple Translations 



Quick Search

 Quick Search is a powerful feature that lets you easily find all occurrences of a word or phrase without 
typing the words in the phrase field of the search dialog box. 

To use Quick Search:

1. Highlight the word or phrase you want to search for by clicking your mouse on the word or 
dragging through a phrase in either the Bible text or your notes.

2. Click the Quick Search icon or select Quick Search from the Search menu. QuickVerse finds all 
occurrences of the word or phrase and displays them in the Search List window. 



Printing

Once you find verses for your Bible study, you'll probably want to print them for later reference. 

You can print the following:

* A single verse.

* Selected verses.

* Search verses.

* A passage that you define, such as Num 9:1-14, Gen-Lev, or even the entire Bible.

* An open index.

* A note from an open note file.

See also:
Print Setup
Printing Bitmaps 



Case-Sensitive Search

You may wish to check the "Perform a case-sensitive search" check box in the Search dialog to limit the 
search by the case of the word. This option tells QuickVerse to search only for the words that match the 
case you have entered. For example, if you entered Lord in the Phrase field of the Search dialog, 
references to lord or LORD would not be listed in the search findings. Likewise, entering LORD would 
cause QuickVerse to eliminate lord and Lord from its search results. You can change the designation for 
this option at any time depending on the nature of your search. 



Reference Searches

Use Reference searches when you know the book, chapter, and/or verse you want to find. You can 
search for a single verse, a range of verses, a chapter, a book, or nonconsecutive verses. 

For example, suppose you want to print Psalm 23. Unlike the Go to Verse feature, which simply moves 
the current verse marker to Psalm 23:1, a Reference search finds the entire chapter. QuickVerse 
temporarily holds Psalm 23:1-6 in its memory, permitting you to print, file, or save the verses to a text or 
index file using the Copy To button. The following are examples of References searches:

One verse John 3:16

A range of verses John 3:16-18 or 
Gen 1:1 - 2:6

Chapter Psalm 23

Book Revelation

Nonconsecutive verses Gen; Acts 1:3; 1 Cor 3:16

Keep in mind the following points when entering Reference searches in the Search dialog:

* QuickVerse recognizes all standard book abbreviations. You can also abbreviate book names by 
typing enough letters to identify the book. You can abbreviate Genesis as Gen, for example.

* You can use periods in place of colons if you prefer. For example, QuickVerse recognizes John 
3.16 as well as John 3:16.

* To specify books such as First Timothy, use a 1 instead of the Roman numeral I. Always use one 
space after the number.

To perform a reference search, 

1. Click the Search icon  to display the Search dialog box. 

2. Then place your cursor in the Reference field and choose one of the following:

* Type the book, chapter, and/or verse(s). 

* Use the Book List.

a. Click the Book List button to display the Book List dialog.

b. Scroll through the lists of books, chapters, and verses and highlight the reference you want. 
The reference also appears in the Go To field.

c. Click the OK button.

* Use a Reference Shortcut. Click the appropriate button to search the Old Testament, the New 
Testament, or whole Bible. 

When you use a Reference Shortcut, QuickVerse fills in the Reference field for you. For 
example, if you click the Old Testament button, Genesis - Malachi appears in the Reference field. 
However, when you click the Whole Bible button, the Reference field is blank because 
QuickVerse searches the whole Bible by default.



If you type a sequence of verses other than the Testaments, for example, Mat-John, QuickVerse 
chooses the Other button automatically. It is never necessary to click this button. 

3. Now click the Search button. QuickVerse displays a Search List Window containing all the 
verses matching your criteria.

See also:
Search Tips 
Using the REF Operator 



Search Tips

When using the Phrase field to search, consider the following:

Apostrophes. When you perform a word or phrase search, QuickVerse treats John's as a separate 
word from Johns. If you search for a word that may or may not be possessive, use a wild card, 
such as John*.

Hyphenated Words. Except for concordances such as Strong's and the NASC, QuickVerse treats 
hyphenated terms as two separate words. Therefore, searching for twenty-nine is the same as 
twenty nine. The concordances (Hebrew/Greek transliterations) treat hyphenated words as one 
word. Refer to the Word List to determine when you need to use hyphens.

Numbers. Sometimes you may need to include a comma in numbers larger than 999. Refer to your 
Word List to determine if you need commas in numbers. Numbers appear in alphabetical order at 
the beginning of each Word List. In translations (such as the NIV) that contain numbers, the 
numbers are displayed BEFORE the first word (usually a) in the word list. Press PgUp or click 
above the elevator box in the scroll bar to see the numbers. All numbers in the Kings James 
translation are spelled out and thus appear in alphabetical order.

Excluded Words. Not all words in the Bible are in QuickVerse's internal concordance. About 50 
words, such as articles and prepositions, do not appear. The Word List indicates these words by 
an asterisk to the left of the word. QuickVerse can find these, but it may take a few seconds 
more than a usual search. 

Case-sensitive searches. This type of search takes a little longer to perform.

Words with wild cards. Words with wild cards placed at the end are found faster than those with wild 
cards placed at the beginning.



Boolean Searches 

 QuickVerse supports a number of Boolean search commands. These commands allow you to perform 
sophisticated searches for multiple words, or to limit the search to verses that do contain certain words, 
but not others, for example. 

The following Boolean search operators can be used in the Phrase field and are listed in a box on the 
right side of the Search window. To use the operators, you can double-click on an item in the list and it will 
be automatically inserted into the Phrase field. The operators must be placed between search words in 
order to be effective, so be sure your cursor is placed in the proper location when double-clicking on an 
operator to insert. You can also simply type the symbol associated with the operator, or type the operator 
word itself (entering it in all uppercase letters) rather than using the picklist. Each operator is described 
below.

Operator Word Symbol
AND &

OR |

NOT !

XOR X

ANDWITHIN# &#

NOTWITHIN# !#

See also:
Wild Cards and Boolean Operators 
Additional Search Commands
Complex Search Examples 



Note File Translations

Select whether to use the note file with the current translation only, or with 
all translations by clicking on the option you desire.

A note file used only with a specific translation can include all types of 
notes, including word notes, but can be used with only that translation. 
Use this type of note to write commentary on specific words in a verse.

A note file used with all translations can contain book, chapter, and verse 
notes, but can not contain word notes since specific words vary among 
different translations. Use this type of note file if you do not need word 
notes and want to be able to use the file with any translation.



Attaching Verse and Word Notes

QuickVerse allows you to attach notes to an entire book or chapter using the Book and Chapter Notes 
feature, and you can attach notes to verses or even individual words:

Verse. You can attach a note to a verse in three ways: 

* Click on the reference
* Double-click on the verse
* Move the current verse marker to the verse you want.

Word. To attach a note to a word, highlight the word. Remember, you can not attach a word note 
if you select All as your translation option. 

You may not attach a note to a group of words (unless it is attached to an entire verse). Therefore, if you 
want to write a comment about a phrase, highlight the last word in the phrase and attach a note to it. After 
highlighting the text, move your cursor to the Note window and click once to get a blinking cursor or select 
Write Note from the Notes menu. The cursor appears as an I-beam in the note window, and you can 
begin typing your note.

When you type a note and include a reference to another verse, QuickVerse will recognize it and tag it as 
a cross reference that you can click on to jump directly to the verse. After you jump to a cross reference, 
you can return to your previous location in the Bible text by clicking on the Previous Reference icon 

 or by selecting Previous Reference from the Browse menu. 

See also:
Fonts
Using Existing Notes 
Listing Notes
Modifying Notes 
Optimizing Note Files 
Read Only Notes 
Closing Notes
Using the KJV Word Study 
Using the NASB Word Study 
Saving Notes 



Using Existing Notes

After creating a note file, you can access it at any time to view notes, add or change them, or delete 
existing notes. 

To use existing notes:

1. If you have more than one translation open, click on the appropriate Bible window to make it 
active.

2. Select Open Notes from the Notes menu. The Open Notes dialog opens. Choose the directory 
and file you want to view.

3. If you have stored your note files in a directory other than the default QuickVerse directory, 
double-click on the directory to display its files. You can configure QuickVerse to access the new 
directory automatically. See Directories for more information.

4. Find the file you want to open. Type the file name in the Note File field, or scroll through the Files 
list to find the one you want.

5. Double-click on the file you want to open, or highlight the file and click OK. A note window opens 
at the bottom of the translation.

See also:
Book and Chapter Notes
Fonts
Cross References 
Listing Notes
Modifying Notes 
Optimizing Note Files 
Read Only Notes 
Closing Notes
Using the KJV Word Study 
Using the NASB Word Study 
Saving Notes 



Listing Notes

 If you want to see a list of verses with attached notes, select the Notes menu and choose List. A Note 
List dialog box appears, showing all the verses with notes for the note file currently open. You also see a 
summary at the bottom of the Note List. The summary tells how many notes are stored in the file, the 
number of verses with notes, the translation, and the note file description.

If you attached more than one note per verse--for example, a word note and a verse note--the verse 
appears only once in the Note List. The number of notes that the Note List indicates have been stored in 
the file may be greater than the number of notes you've written. This is because QuickVerse may use 
some empty notes as place holders.

To look at an existing note, double-click on a verse in the list. If the note is attached to a word, you must 
highlight the individual word to view the note. Verse and word notes are marked with a degree symbol. If 
the note is attached to a verse, highlight the reference or the entire verse to see the note.

You can configure QuickVerse to close the Note List dialog box after you select a verse. Doing so closes 
the Note List dialog box, allowing you a clear view of the selected verse. Otherwise, you may want to 
move the dialog box out of the way by clicking and dragging its title bar. See Display Options for more 
information. 

See also:
Book and Chapter Notes
Fonts
Cross References 
Using Existing Notes 
Modifying Notes 
Optimizing Note Files 
Read Only Notes 
Closing Notes
Using the KJV Word Study 
Using the NASB Word Study 
Saving Notes 



Modifying Notes

 

You can add, edit, or delete notes at any time.

Add notes. Highlight the word or verse you want. Then click your cursor in the note window and 
type your comments.

Edit notes. Highlight the word or verse with the note attached. The note appears in the note 
window. When you click in the note window, the cursor becomes an I-beam, much like the one in 
a word processor. You can change your note as necessary. To use your keyboard instead of the 
mouse, select Write Note from the Notes menu. Your cursor appears in the note window. When 
you're finished, select Write Note again to return to the Bible window.

Delete notes. To delete a note, make sure it appears in the note window and select Delete Note 
from the Notes menu. As a safety measure, QuickVerse verifies that you want to remove the 
note. Once you delete a note, you cannot undo the action.

The standard clipboard operations are available when you are editing your note. The Edit shortcut keys 
for Windows version 3.1 are displayed in the QuickVerse Edit menu. However, for those of you familiar 
with the shortcut keys used by Windows version 3.0, QuickVerse also will respond to the older Edit 
shortcut keys if you prefer to use these.

Operation Windows 3.0 Windows 3.1

Copy Ctrl+Insert Ctrl+C

Paste Shift+Insert Ctrl+V

Cut Shift+Delete Ctrl+X

Undo Alt+Backspace Ctrl+Z



Saving Notes

QuickVerse will automatically save your changes before a new note is displayed. Or you can choose to 
save your changes immediately by selecting Save Note from the Notes menu. If you modify a note by 
mistake, you can choose to discard the changes by selecting Discard Changes from the Notes menu. All 
changes since the last save will be abandoned.

When you attach a verse or word note, a degree symbol appears next to the word with the note attached. 
If a book note is present for a book, then a symbol similar to a superscript o' is added to the first verse in 
the book. If a chapter note is present for a chapter, then a symbol similar to a superscript a' is added to 
the first verse in the book. This makes it easy to find your notes as you scroll through the Bible text.

See also:
Book and Chapter Notes
Fonts
Cross References 
Using Existing Notes 
Listing Notes
Modifying Notes 
Optimizing Note Files 
Read Only Notes 
Closing Notes
Using the KJV Word Study 
Using the NASB Word Study 



Optimizing Note Files

Packing notes refers to compressing note files on your disk to optimize the use of the files. Packing may 
reduce the size of the note file and sorts the notes to reduce the time it takes to display one. As you add 
notes to a file or edit and delete existing ones, the efficiency of reading the file gradually deteriorates. 
While you will probably not notice the decreased performance, it is still a good idea to pack the file 
occasionally. Make a backup of your note files before you pack them. To pack a note file, make sure the 
note file is open and in the active window. Then select the Notes menu and choose Pack Notes.

See also:
Book and Chapter Notes
Fonts
Cross References 
Using Existing Notes 
Listing Notes
Modifying Notes 
Read Only Notes 
Closing Notes
Using the KJV Word Study 
Using the NASB Word Study 
Saving Notes 



Closing Notes

 
To close your notes, select the Notes menu and choose Close Notes. If you want to open a second note 
file, choose Open Notes and double-click on a file. The first note file automatically closes when you open 
another file.

See also:
Book and Chapter Notes
Fonts
Cross References 
Using Existing Notes 
Listing Notes
Modifying Notes 
Optimizing Note Files 
Read Only Notes 
Using the KJV Word Study 
Using the NASB Word Study 
Saving Notes 



Search List Window

After you define your criteria and perform a search, QuickVerse provides you with a Search List window. 
You can also display the Search List from your latest search by clicking the Search List icon 

 or choosing List Occurrences from the Search menu. 

The Search List displays every verse matching your search criteria. QuickVerse also tells you how many 
matches occurred and the number of verses they appeared in. The criteria you specified for the search 
also appear in a box at the bottom of the window. The verse references and an excerpt from the text of 
each verse are displayed in the Search List. 

You can view the passages in the Search List in several ways:

* With the Search List window open, highlight the verse you want to view and click the View button 
or double-click on the verse. QuickVerse scrolls to that verse. You can configure QuickVerse to 
automatically close the Search List after you select a verse. See Display Options for more 
information.

* If you close the Search List window but want to view it again, select List Occurrences from the 
Search menu. The Search List appears.

* Click the Previous Verse and Next Verse icons in the icon bar to view the previous or next verse 
in the Search List, starting with the current verse, or select the Search menu and choose 
Previous Occurrence or Next Occurrence. The Search List doesn't have to be displayed to use 
these options.

If you search for a word or phrase with the Display search word in boldface option marked, the word or 
phrase appears in bold in the Bible text. In some fonts, however, boldface is hard to discern. Try using 
another font if your bold text doesn't provide enough contrast. 

See also:
Copying Search Verses 



AND as a Boolean Operator

An AND search lets you find all verses containing all the words you specify. To perform an AND search, 
start a search by choosing Search from the Search menu. Type each word you're interested in finding into 
the Phrase field, separating each word by an ampersand character (&). 

To insert the Boolean operator into the Phrase field, you can also simply double click on the command 
you wan to use in the pick list displayed to the right of the Phrase field. Be sure to place the operator 
between the search words in the Phrase field. 

For example, to find all verses containing the names Peter, James, and John, enter the following as the 
phrase: Peter & James & John. When you start the search, all verses that contain all three names in any 
order will be found. The names can be separated by other words in the verse and do not have to appear 
side by side. 

See also:
OR 
NOT
XOR
ANDWITHIN# 
NOTWITHIN# 



OR as a Boolean Operator

An OR search lets you find all verses containing any one or more of the words you specify. To perform an 
OR search, start a search and in the Phrase field, type the words you want to find, separating each word 
by a vertical bar character (|--usually Shift+\) or the operator OR. For example, to find all the verses 
referring to Peter, who is also sometimes referred to as Simon or Simon Peter, you would enter Simon 
OR Peter in the Phrase field. QuickVerse would then locate all verses containing Simon, Peter, or both. 

To insert the Boolean operator into the Phrase field, you can also simply double click on the command 
you wan to use in the pick list displayed to the right of the Phrase field. Be sure to place the operator 
between the search words in the Phrase field. 

See also
AND 
NOT
XOR
ANDWITHIN# 
NOTWITHIN# 



XOR as a Boolean Operator

The XOR operator causes QuickVerse to search for all verses that contain one or more words specified 
but not both. To perform an XOR search, start a phrase search and type the words you want to find, XOR 
(or X), followed by the other word you want to find in the Phrase field. For example, you might want to 
type John XOR James, causing QuickVerse to locate all verses that contain John or James, but never 
both names at once.

To insert the Boolean operator into the Phrase field, you can also simply double click on the command 
you wan to use in the pick list displayed to the right of the Phrase field. Be sure to place the operator 
between the search words in the Phrase field. 

See also:
AND 
OR 
NOT
ANDWITHIN# 
NOTWITHIN# 



ANDWITHIN# and NOTWITHIN#

These Boolean operators are called "proximity" search operators because they allow for a search for 
words or phrases that are within a certain distance of another word or phrase. In the case of these 
operators, the # symbol is replaced with the number of verses that can separate the two words or phrases 
and still satisfy your search criteria. 

To perform a search using one of these operators, start a search by choosing Search from the Search 
menu and enter John ANDWITHIN2 James (or your own search words) in the Phrase field of the Search 
window. QuickVerse will find all verses containing the word John and all the verses containing the word 
James that are within two verses of each other. Using NOTWITHIN2 would find all verses containing the 
word John that are not within 2 verses of a verse containing the word James. You can also use the 
symbol &# for the ANDWITHIN# operator and !# for the NOTWITHIN# operator. 

To insert the Boolean operator into the Phrase field, you can also simply double click on the command 
you wan to use in the pick list displayed to the right of the Phrase field. Be sure to place the operator 
between the search words in the Phrase field. 

See also:
AND 
OR 
NOT
XOR



NOT as a Boolean Operator

Using the NOT operator results in all of the verses that contain the designated word(s) and not another 
that you specify. For example, entering James NOT John would find all verses that contain the word 
James but not the word John. To use the NOT command, separate the word or words you want the verse 
to include from the word you don't want to include using NOT or the exclamation point (!). For another 
example, you might type John AND James NOT brother.

To insert the Boolean operator into the Phrase field, you can also simply double click on the command 
you wan to use in the pick list displayed to the right of the Phrase field. Be sure to place the operator 
between the search words in the Phrase field. 

See also:
AND 
OR 
XOR
ANDWITHIN# 
NOTWITHIN# 



Read Only Notes

The Read Only option on the Notes menu can be used to prevent any accidental changes being made to 
a note file. Selecting Read Only while the Note file is open will cause QuickVerse to recognize the file as 
read only and therefore not allow modifications to be made to it. You can toggle this option on or off by 
selecting it from the Notes menu with the appropriate note file open. A check mark appears next to the 
option if the current note file is a read only file. This item is automatically set by the program if it detects 
that the file has been marked as read-only by DOS or if the file is on read only media, such as a CD-ROM 
disk. 

See also:
Creating and Opening Note Files 
Attaching a Note 
Formatting Notes with Color and Font 
Using Book and Chapter Notes
Optimizing Note Files 
Using the KJV Word Study
Using the NASB Word Study 



Opening a New or Existing Index

You can create your own index of verses in QuickVerse to store groups of verses for later reference. 
Before you can add verses to an index, you must open or create an index file.

To create or open an index:

1. Select the Index menu and choose Open Index. The Open Index dialog box appears.

2. Choose one of the following.

To create a new index:

a. Verify the directory in which you want to place the index file. (To change the directory, double-
click on the one you want in the Directories list in the Open Index dialog. Double-click on the 
[..] item to access the parent directory of the current subdirectory.) By default, the program 
uses the QuickVerse directory (for example, C:\QVWIN), but you can choose another 
directory. You can configure QuickVerse to access a different directory automatically. See 
Directories.

b. Type the name of the index in the Index File field and click OK. File names consist of eight or 
fewer characters for the name, a period, and a three-character extension. By default, 
QuickVerse gives index files the extension .INX if you don't type another one. The program 
asks if you want to create the new index file.

c. Click the Yes button. QuickVerse displays the New Index dialog box asking for a description of 
the index.

d. Type a brief description of the index in the Description field to help distinguish one index from 
another. For example, Marriage and love in the New Testament.

e. Choose one of the following to arrange the verses:

Sorted. QuickVerse automatically arranges verses in the order they appear in the Bible.

Unsorted. You arrange the verses as you add them. You can include the same verse more 
than once.

f. Click the OK button.

To open an existing index:

a. Double-click on the directory containing the index file.

b. Click on the index file in the Files box. The name of the file appears in the Index File field.

c. Click the OK button.

When QuickVerse opens the index file in the active window, it displays the Index List window for the 
active Bible window. Click Close to remove the dialog from your screen. The index will remain open, as 
indicated in the status bar at the bottom of your screen. 

See also:
Adding Verses to an Index 
Viewing Verses in an Index 



Editing an Index 
Merging and Duplicating Indexes 
Searching Indexes 
Closing Indexes 



Adding Verses to an Index

You can add verses relating to specific topics to indexes. For instance, the phrase "family values" never 
appears in the Bible, so you can't search for it. But you can save verses that are appropriate for a 
discussion of family values. There are several ways to add verses to an index:

* Add one verse at a time as you browse the Biblical text. 

* Add blocks of selected verses as you browse the Biblical text.

* Add all verses from a Search List.

* Add selected verses using the Copy To button from other dialogs.

To add verses to an index:

1. If you have more than one translation open, click on the appropriate window to make it active. 

2. Add verses to your index in one of the following ways:

Add one verse or all selected verses.

a. Highlight the verse or verses you want to add.

b. If the open index is "unsorted," you must tell QuickVerse where to insert the verse. Select List 
from the Index menu. The Index List appears, displaying all the verses in the index. Highlight a 
verse. The new verse will be added after the highlighted verse.

Remember to actually highlight the verse you're using as a locator. Just scrolling to a new 
location on the list does not move the highlight. 

If the index is "sorted," QuickVerse will insert the verse in Biblical order, so you don't need to 
choose a location.

c. Choose Add Verses from the Index menu; then click on Current Verse. QuickVerse places the 
selection just below the highlighted verse in the index (or into its appropriate position if the 
index is sorted).

Add all verses from a search.

a. Perform a search. QuickVerse displays a Search List.

b. If the open index is "unsorted," you must tell QuickVerse where to insert the verse or verses. 
(See Step b above for more information on this step.)

c. Choose Add Verses from the Index menu; then click on All Search Verses. QuickVerse copies 
the verses to the index just below the one you highlighted (or into its appropriate position if the 
index is sorted).

See also:
Viewing Verses in an Index 
Editing an Index 
Merging and Duplicating Indexes 
Searching Indexes 
Closing Indexes 



Viewing Verses in an Index

The Index List window lists all the verses in the index. The index name appears in the status bar at the 
bottom of the desktop. The Close button in the Index List window closes the list, not the index. You can 
use the Index List to view verses and edit the contents of the index.

You can view the verses stored in an index file. For example, at Christmas time, you might want to look at 
the index of verses for last year's Christmas sermon. To view index entries:

1. Open the index you want to view; or, with the index you want to view already open, choose List 
from the Index menu. In either case, an Index List window appears displaying all the verses in the 
index.

At the bottom of the Index List window, QuickVerse tells you the number of verses in the index 
and its name, description, and type (sorted or unsorted). 

2. To view a verse, highlight the reference you want and click the View button (or double-click the 
desired verse.) QuickVerse moves the current verse marker to the verse. You can configure 
QuickVerse to automatically close the Index List after you select a verse. See Display Options for 
more details.

See also:
Editing an Index 
Merging and Duplicating Indexes 
Searching Indexes 
Closing Indexes 



Editing an Index

You can modify the contents of an index. For instance, after reviewing the Christmas verses, you might 
decide to update the index file. QuickVerse lets you add and delete verses within an index. If the index is 
"unsorted," you can arrange and duplicate verses. To edit index entries:

1. Select the Index menu and choose List. A list of all the verses in the current index appears.

2. Choose one of the following:

To add index entries, see Adding Verses to an Index.

To delete index entries:

a. Highlight the verse you want to delete by using the arrow keys or clicking on it with your 
mouse. To select a range of verses, highlight them by holding down the mouse button and 
dragging; or press Shift and click the mouse or press Shift + the appropriate arrow key.

b. Click the Edit button and choose Cut from the submenu that opens. QuickVerse deletes the 
verse from the index. You can bring the last deleted verse back into the index by clicking the 
Edit button and choosing Paste. You can recover the last deleted verse ONLY while the index 
file is open. After that time, it is permanently erased.

To move index entries in an unsorted file:

a.Highlight the verse you want to move by using the cursor keys or clicking on it with your mouse.

b.Click the Edit button and choose Cut from the submenu that opens. QuickVerse deletes the 
verse from the index. 

c.Move your cursor to where you want to insert the verse. QuickVerse inserts the verse below 
the highlighted one.

d.Click the Edit button again; then choose Paste. QuickVerse inserts the verse in the new 
location.

To duplicate index entries in an unsorted file:

a. Highlight the verse you want to duplicate by using the cursor keys or clicking on it with your 
mouse.

b. Click the Edit button and choose Copy from the submenu. 

c. Move your cursor to where you want to insert the verse. QuickVerse inserts the verse below 
the highlighted one.

d. Click Edit again, this time choosing Paste from the submenu. QuickVerse inserts the verse in 
the new location.

See also:
Merging and Duplicating Indexes 
Searching Indexes 
Closing Indexes 



Duplicating and Merging Indexes

You can duplicate the contents of an open index file into a new index using the Search function. This is an 
efficient way to create a new index file containing verses from an existing index plus additional verses. 
Your original index remains intact, plus you have a new one.

For example, perhaps you created an index about tithing and now want to conduct a study on 
stewardship. You might start with all the verses about tithing and add new verses. To do so, duplicate the 
tithing index and change the name to reflect the new topic and index. Then add additional verses to your 
new index on stewardship using the methods described in Adding Verses to an Index. Duplicating an 
index also is a good method to transform a sorted index to unsorted or vice-versa. 

To duplicate an index:

1. Create a new index. This is the index that will RECEIVE entries from the existing index.

2. Perform a Search on the existing index. When the search is complete, the Search List appears 
displaying all the entries in the existing index.

3. Choose Add Verses from the Index menu, then All Search Verses.

4. The entries from the search (remember, these are the verses contained in the original file) will 
now appear in the new index.

In the same manner, you can merge entries from one index into another existing one. Open the index that 
you want to RECEIVE the entries; then perform a Search on the index currently containing the entries. 
When the search is complete, choose Add Verses from the Index menu and click on All Search Verses. 
The entries from the index on which you performed the search are added to the open index.



Closing an Index

To close an index, select Close Index from the Index menu. You don't have to close an index to open 
another. Once you close an index, you cannot access its verses until you open the file again. It is not 
necessary to close indexes before exiting the program. 



Searching with an Index

 
You can use the indexes you've created to refine other searches. To perform an index search, click the 
Search icon to display the Search dialog box. Then, place your cursor in the Index field and choose one 
of the following:

* Type the name of the index.

* Use the Index List.

a. Click the Index List button to display the Index List dialog.

b. Scroll through the list of indexes and highlight the file you want. You may need to change 
drives or directories.

c. Click the OK button.

Now click the Search button. QuickVerse displays a Search List of all the verses matching your criteria. 
For more information about viewing verses in the Search List, see The Search List Window.

You can also perform complex searches with an index using the INDEX operator in the Phrase field of the 
Search window. See Additional Search Commands for details.

For information on creating an index, see Adding Verses to Indexes.

See also:
Word and Phrase Searches with an Index 
Complex Index Searches 



Additional Search Commands

QuickVerse provides three functions that allow you to combine words or phrases with the concordances 
from index files, Nave's Topics, or a specific reference. Using these commands allows you to designate 
greater detail in the search by causing certain search commands to occur at a certain point in the 
process. 

The additional functions are as follows and appear in the list box on the right side of the Search window. 
Double-click on an item in the Search window to automatically insert it into the Phrase field:

INDEX[index file name]
NAVES[Nave's topic name]
REF[Bible reference]

When using the functions, replace the text enclosed in brackets ([ ]) with the specific item you'd like to 
include in the search. Examples of ways to use these functions include:

Saul AND REF[1 Sam] OR Samuel--Finds verses containing Saul in the book of I Samuel, and verses 
containing Samuel anywhere in the Bible.

(love AND REF[matt-john]) OR (charity AND INDEX[paul.inx])--Finds all verses in the gospels with the 
word love and all verses from the PAUL.INX index file that also contain the word charity.

See also:
Boolean Operators 



Exiting QuickVerse

You can exit QuickVerse any of three ways:

* Select Exit QuickVerse from the File menu.

* Select Close from the Control-menu box.

* Double-click on the Control-menu box.

The Exit QuickVerse dialog box appears. Now you have the option of saving your current desktop. If you 
choose to save, QuickVerse restores all your Bible windows the next time you start the program. To save 
your desktop, check the Save Desktop box. Click the OK button to exit the program, or click the Cancel 
button to return to QuickVerse.

You can disable or turn off the prompt to confirm that you want to exit QuickVerse. See Options for more 
information.

If you don't want to exit QuickVerse, you can minimize the program by clicking the Minimize button and 
return to it later. 

You can then return to where you left off by double-clicking on the QuickVerse icon later. 



Phrase Searches

Use a Phrase search to locate verses containing a specific word or phrase. To perform a phrase search:

1. Click the Search icon  to display the Search dialog box. 

2. Complete the Phrase field choosing from these options:
Type the word or phrase. For example, type John the Baptist.

Copy a word or phrase from the Bible and paste it in the Phrase field. Before searching, 
highlight the word or phrase in the text and select Copy from the Edit menu. Click the Search icon 
to display the Search dialog box. Move your cursor to the Phrase field and press Ctrl+V to paste 
the selected text.

Use the Word List. Click on the Word List button to display all the words in the Bible. Use the 
arrow keys to scroll through the list or type the first few letters of your selection. Highlight the 
desired word, double-click on it, and press Enter or click the OK button to select it. You are 
returned to the Search dialog box and the word you selected appears in the Phrase field. 

Each entry in the word list contains a word and the number of times it occurs in the Bible. If a 
word has an asterisk to its left (such as *a or *the), that means it occurs very frequently and is not 
included in the internal QuickVerse concordance database. (See Phrase Search Tips for more 
information about these excluded words.)

The Strong's Concordance and the NASC word lists contain one other piece of information. The 
Strong's word number  for each word is displayed in the center column preceded by an H for 
Hebrew or a G for Greek.

Use a wild card.

Use a Boolean search. You can use a number of Boolean search operators with words you enter 
in the Phrase field. Boolean commands can help you find multiple words or limit the search to find 
very specific criteria. 

Case-sensitive searching. You may wish to check the Perform a case-sensitive search check 
box to limit the search by the case of the word. This option tells QuickVerse to search only for the 
words that match the case you have entered. For example, if you entered Lord, references to lord 
or LORD would not be listed in the search findings. Likewise, entering LORD would cause 
QuickVerse to eliminate lord and Lord from its search results. You can change the designation 
for this option at any time depending on the nature of your search. 

3. Once you've completed the Phrase field entries, click the Search button. QuickVerse displays a 
Search List window listing all of the verses containing the word or phrase you specified. 



The Search Dialog Box

The Search dialog box is the primary tool for initiating a QuickVerse search. To use it, click the Search 
icon or choose Search from the Search menu. The Search dialog box offers four search fields. Use them 
alone or in combination to search for as many or as few items as you want.

Phrase. Locate verses containing words or phrases in the Bible. When you place your cursor in 
this field, the Word List button appears at the bottom of the dialog box. With your cursor in the 
Phrase field, the Boolean command list on the right side of the Search dialog is active. 

Sometimes, when entering a complex set of search criteria, you may find it helpful to expand the 
Phrase field by clicking 

 
 This will enlarge the Phrase field so that you can view the entire entry easily. 

To return the Phrase field to its original size, click 

 
Reference. Locate specific verses or limit the search by book, chapter, and/or verse. When you 
move your cursor to this field, the Book List button appears at the bottom of the dialog box. Click 
this button to see a list of books, chapters, and verses.

Index. Locate verses in an index or limit the search to a previously created index. When you 
position your cursor in this field, the Index List button appears at the bottom of the dialog box. 
Click this button to locate index files.

Nave's. If you have installed Nave's Topical Bible, you can search the Bible by topic. When you 
position your cursor in this field the Topic List button appears at the bottom of the dialog box. 
Click the button to display a list of Nave's topics.

The Reference Shortcut box appears along the bottom of the Search dialog box. Instead of manually 
typing in the Reference field, you can click a button to choose the whole Bible, Old Testament, New 
Testament, or "other," a section you specify. 

When you use a Reference Shortcut, QuickVerse fills in the Reference field for you. For example, if you 
click the Old Testament button, Genesis - Malachi appears in the Reference field. However, when you 
click Whole Bible, the Reference field is blank. By default, QuickVerse searches the whole Bible. If you 
want a sequence of verses other than the Testaments, for example, Mat-John, you must type the 
references in the Reference field. QuickVerse chooses the Other button automatically. It is never 
necessary to click this button. 

See also:
Combining Fields to Narrow Searches 
Performing a Search 
Phrase Searches 
Viewing Search Verses 
Search Tips
Boolean Operators
Wild Card Searches 



Complex Search Examples 
Reference Searches
Returning to a Previous Search 
Copying Search Verses 
Nave's   Topic Searches   
Using the Word List 
Using the Book List 



Complex Search Examples

Here are some examples of the types of complex searches that are possible with QuickVerse for 
Windows. 

* John AND James NOT brother--finds verses containing the word John and the word James but 
not the word brother.

* Pharisee* OR Sadducee* AND woe--finds verses containing the word woe and either of the 
words Pharisee or Sadducee with any ending.

* Jesus OR Christ AND Pharisee*--finds verses containing the word Pharisee with any ending 
along with the word Jesus or Christ.

* Jesus ANDWITHIN2 son of man--finds verses containing the word Jesus and verses containing 
the phrase son of man that are within two verses of each other.

* (Jesus & (Peter | James | John)) &3 Transfig*--finds verses containing the word Jesus and any 
one or more of the words Peter, James, or John. The group found in that search we'll call Set A. 
Next, all verses containing forms of the word with the root transfig are found. That group we'll call 
Set B. Finally, the end result is a set of verses in Set A and Set B that are within three verses of 
each other.

* Barnabas AND (Saul OR Paul)--finds verses containing either Saul or Paul along with Barnabas.

Note the use of parentheses to group operations for evaluation before other operations. In the last 
example, Saul OR Paul would be evaluated first and then the result would be combined with Barnabas 
using the AND operator. When parentheses are not used, the operations are performed in order from left 
to right with the result of each operation combined with the next word or phrase to the right.

See also:
Boolean Search Operators 
Additional Search Commands 



Wild Cards and Boolean Operators

You can use partial words in combination with Boolean searches. For example, to find references to 
Aaron or Levi, you might want to find Aaron, Aaron's, Aaronic, Levi, Levitical, etc. The best way to specify 
this search would be to use an OR search for all forms of Aaron or Levi. To do so, you would enter the 
following in the Phrase field of the Search dialog: Aaron* | Levi*.



Returning to a Previous Search

QuickVerse allows you to return to searches you've already performed. Select Previous Searches from 
the Search menu to open the Previous Searches dialog. QuickVerse remembers the results of 50 
previous searches and displays each one in the list box on the left side of the dialog box. Highlight one of 
the searches by clicking on it. Note the Summary section on the right side of the dialog as you highlight a 
search in the list. The Summary box displays the search criteria you defined for the highlighted search, as 
well as the number of occurrences of the search word or phrase. 

The buttons along the bottom of the dialog allow you to:

Restore
Click on the Restore button to access the results of the highlighted search. This button makes the 
selected search active in the Bible window. So, for example, if you then selected List Occurrences from 
the Search menu, the Search List window would display all the occurrences from the search you chose to 
return to. 

Clear
Click the Clear button to remove all Searches in the Previous Searches list box from QuickVerse's 
memory. A warning dialog will ask you to confirm the action.

Close
Click the Close button to close the dialog box and return to the Bible window.

Help
Click the Help button to access the help topic for the Previous Searches dialog.

The "Close this window when a search is restored check box" allows you to choose whether the dialog 
will close or remain open once you execute the Restore button. Marking this box by clicking on it will 
cause QuickVerse to automatically close the dialog and return you to the Bible window when you 
execute Restore.

See also:
Exiting the Program 
Viewing Search Results 



Copying Search Verses

As you view the verses produced by a search, you can select and copy them directly to the Windows 
Clipboard, the printer, or the currently open text or index file. To do so, select the verses to be copied by 
clicking and dragging on them in the Search List window. Then click the Copy To button in the Search List 
window. The Copy To dialog will appear. Click the desired destination; then click OK.



Nave's Topic Searches

Nave's Topical Bible, an add-on module for use with QuickVerse organizes the Scriptures by topic in 
the form of an outline. It's like a QuickVerse index file containing over 20,000 topics and subtopics. Use it 
by itself in a search or in combination with other search options. You can also add your own topics to 
Nave's, modify existing topics, or change the references cited under a topic. 

Searching Nave's often turns up more extensive and complete results than searching for a word or 
phrase. For example, if you performed a word search on marriage, the search turns up only 19 verses. 
However, if you search for the Nave's Topic marriage, you find 369 verses on the topic, because the 
concept is discussed using words other than marriage.

Besides using Nave's in a search, you can also use it as a source of sermon outlines and Bible studies, 
and as a Bible Dictionary. 

See also:
Accessing   Nave's Topical Bible   
Finding a   Nave's   Topic   



Accessing Nave's Topical Bible

To access Nave's topics for searching, click the Search icon to display the Search dialog box. Then, 
place your cursor in the Nave's field and choose one of the following:

* Type the word you want. If the word does not match a Nave's topic, the Nave's Topical Bible 
dialog box appears when you try to move the cursor out of this field. 

* Click the Topic List button. The Nave's Topical Bible dialog box appears.

See also:
Using   Nave's Topical Bible   
Searching with   Nave's   
Creating New   Nave's   Topics and Subtopics   
Modifying Topics and Subtopics 
Deleting Topics and Subtopics 
Copying   Nave's   Topics   



Finding a Nave's Topic

You can browse through the Nave's topics using your mouse and the scroll bar. When you first view the 
Nave's list you'll see only the main topics. To see the subtopics, select Detail from the Nave's Edit menu.

You can also do an automated search of the Nave's topics. To perform a search, do the following:

1. Select Search from the Search menu on the Nave's Topical Bible dialog box. The Find Nave's 
Topic dialog box appears.

2. Type the word you want to search for in the Find field.

3. Click the appropriate Direction button to tell QuickVerse which way to search through the topics: 
forward or backward.

4. Choose one of the following:

* Search TOPICS only. Click this box to have QuickVerse search only major topic headings for 
the word.

* Find words ANYWHERE on line. Click this box to have QuickVerse search for all occurrences 
of the word, regardless of whether it appears at the beginning of a line or within it.

* Both Search TOPICS only and Find words ANYWHERE on line. Click both boxes to have 
QuickVerse search anywhere within major topic headings for the word. For example, if you 
search for marriage using both of these tactics, QuickVerse finds Marriage and Miscegenation 
(intermarriage).

* Neither Search TOPICS only nor Find words ANYWHERE on line. Leave both boxes blank to 
have QuickVerse search for the word only if it appears as the first word of the topic or subtopic. 
For example, if you search for marriage with neither box checked, QuickVerse finds not only the 
major topic heading of Marriage, but also Marriage of, a subtopic of Aaron. 

5. Click the OK button. QuickVerse searches Nave's for the word and highlights it. You can use 
your arrow keys to scroll through the surrounding topics and subtopics.

6. The search word may be listed within other topics. Choose Search Again from the Search menu 
to find the next occurrence.

7. You may come across subtopics with cross-references indicated by See. To view a cross-
referenced subtopic, highlight it and choose Goto see' Subtopic from the Search menu (or press 
F6). QuickVerse takes you to the subtopic.

8. Once you've found the desired topic, highlight it and click OK. QuickVerse transfers the topic to 
the Nave's field in the Search dialog box.

NOTE: You can also use Nave's in combination with the other search fields. For more 
information, see Combining Fields to Narrow a Search.

If you select a topic that has subtopics beneath it, QuickVerse will find all the verses in all the subtopics.

If you select a topic that has "See" cross-reference entries beneath it, QuickVerse will NOT include the 
cross referenced verses in the search. Because of the extensive cross-referencing in Nave's, it would be 
possible to include almost every verse in the Bible if all cross-references were followed.

If you select a topic that is a "See" cross-reference itself, or a topic whose subtopics are only cross-
references, or a topic which for some other reason has no verses associated with it or any of its 
subtopics, an information box stating that there are no verses for that entry will be displayed.



See also:
Using   Nave's Topical Bible   



Word and Phrase Searches with an Index

Use a word search with an index to locate the verses in an index containing a specific word. For instance, 
to locate all verses in an index concerning marriage that contain the word husband, you might enter 
Husband in the Phrase field and MARRIAGE.INX in the Index field of the search window. (Note that it is 
not necessary to indicate the .INX extension; simply specifying the name of the index is sufficient.)

You can also search an index of verses for all instances of a particular phrase. For instance, to locate all 
verses in an index on marriage that contain the phrase Jesus said, you would enter Jesus said in the 
Phrase field and the name of the index you want to search in the Index field of the Search window. 

You may want to combine the use of a wild card to ensure that you find as many forms of the phrase or 
word in the index as possible. For example, entering Jesus sa* in the Phrase field would locate all 
occurrences of Jesus said, Jesus saith, and so on, that the index contains. 

See also:
Creating an Index 
Using the INDEX Operator 



Complex Index Searches

Boolean operators are not valid entries for the Index field. You can only specify one index to search in this 
field, but you can enter the INDEX[] operator in the Phrase field to perform searches for verses common 
to two or more indexes. 

For instance, if you had an index on the topic of tithing and another on the topic of stewardship, and you 
were interested in seeing which verses appeared in both indexes, you could enter the following in the 
Phrase field: 

INDEX[TITHING.INX] AND INDEX[STEWARD.INX]

To find all the verses specified in either of the indexes, use the OR command by entering a statement in 
the Phrase field such as:

INDEX[TITHING.INX] OR INDEX[STEWARD.INX] 

This search will simply display all verses in each index in the Search List window for you to access.

See also:
Complex Search Examples 
INDEX as a Search Operator



Combining Fields to Narrow Searches

You can use the four search fields (Phrase, Reference, Index, and Nave's) alone or in combination. Using 
the search fields in combination further refines your search to produce more specific results, since the 
verses found must satisfy all criteria. As an example, you might want to limit a Boolean Phrase search of 
Paul OR Saul to Mat-Rev. Otherwise your search not only finds all occurrences of Paul in the New 
Testament but also of King Saul in the Old Testament. Here are some examples:

* Suppose you have an index containing all of the words of Jesus, called JESUS.INX. To find every 
place Jesus mentions sin, enter sin in the Phrase field and JESUS.INX in the index field.

* To further limit the search above to the Gospel of Matthew, type Mat in the Reference field along 
with the phrase sin and the index JESUS.INX.

* If you own the Nave's concordance, you can find references to marital love by entering love in 
the Phrase field and marriage in the Nave's field.

See also:
Reference Searches 
Using Boolean Commands 



Cross References

The cross referencing capabilities that QuickVerse offers can help you enhance your Bible study. Cross-
referencing allows you to enter your own cross references in your notes and jump to those cross 
references with the click of a mouse. 

When you type verse references into your notes QuickVerse creates a cross reference. When the note is 
saved, QuickVerse automatically identifies your cross references and tags or marks them in a color you 
designate. These cross references will appear in green, but you can change the color using the verse 
reference color selection available on the Fonts menu. The cross references will be displayed in color 
once the note has been saved (by choosing Save Note from the Notes menu, or by simply clicking your 
mouse outside of the Note window). 

When entering cross references, keep the following tips in mind.

* Most standard book abbreviations are recognized.

* You may specify a full reference (as in Gen 1:1), only a chapter and verse (1:1), or simply a verse 
(v. 1). 

* If you don't use a full reference (including a book name) and use a name that is also a book name 
(as in Matthew, Mark, Luke, or John), you may "trick" QuickVerse into linking to the wrong book. 
For instance, if you write the following note in the book of Acts: 

"Luke also discusses this in 3:1," 

QuickVerse will link to Luke 3:1 instead of Acts 3:1 as intended. You can correct this by 
specifying the intended book name in the cross reference.

Accessing a Cross-Referenced Verse
Once the cross reference is created, you can double-click on the referenced verse in your Note window to 
jump to that verse in the text. The Bible window will move to that point in the text and display that verse.

Additionally, Parsons Technology offers several note files, available as QuickVerse add-on modules, that 
include cross references to verses, charts, maps, and other pictures. These products include:

The Believer's Study Bible
New Scofield Study Bible
Treasury of Scripture Knowledge

See also:
Using Study Bibles 
Returning to the Previous Reference 
Using the Reference Trail 
Reference Trail Example 



Reference Trail Example

Suppose that you have a note file with the following notes and cross references already entered: John 
3:16 has cross references to 1 Tim 1:15, 16; John 3:15; and, Rev 22:17. John 3:15 has cross references 
to: John 1:12, John 6:40; and, Acts 16:30-31. Acts 16:30 has cross references to Acts 2:21, Acts 4:12 , 
and Acts 11:14. 

The cross reference and previous reference features make it easy for you to start at John 3:16 and follow 
all of the cross references. You can travel along any of the branches by clicking on a cross reference and 
retrace your steps by selecting Previous Reference from the Browse menu or by clicking the Previous 

Reference icon . 

Start at John 3:16 and double-click on the 1 Tim 1:15 cross reference. After viewing the verse, return to 
John 3:16 by clicking the Previous Reference icon. Then, double-click on the John 3:15 cross reference. 
The note attached to John 3:15 refers to three other verses in our example. Select Acts 16:30 to view that 
verse. 

By this point, you are several jumps away from your starting point of John 3:16. Use the Reference Trail 
option from the Browse menu to return quickly to that verse. Simply select Reference Trail from the 
Browse menu. The dialog that opens contains a list of the references you've viewed. Double-click on the 
verse you want to return to and the Bible window will display that verse. The Reference Trail will be 
updated when you make your selection and the verses associated with that vein of your study will be 
removed from the Reference Trail list. 



README File

 This file includes information about any program features not available when the User's Guide and online 
help were written. You'll have the chance to read the file when you install QuickVerse, or you can access 
the file later using the README icon in the program group where you installed QuickVerse.

See also:
Getting Technical Support 
Help Menu 



Dynamic Data Exchange (DDE)

Dynamic Data Exchange makes moving data between different applications, such as QuickVerse and 
your word processor, easy. On the surface, DDE is simple: one program is linked to another. The result is 
similar to copying verses to the Windows Clipboard from QuickVerse and then pasting them into your 
word processor documents, but the direct link allows you to perform the entire process from your word 
processor.

DDE is analogous in some ways to a network and uses some of the same terminology. The first 
application (QuickVerse) is referred to as the Server, and the application the data is exported to (your 
word processor) is called the Client. The data transfer is one-way only, from the server to the client. To 
use DDE with QuickVerse, all you have to do is tell your Windows word processor how to establish the 
link and then tell it which verses you want.

A complete technical reference for DDE supported by QuickVerse is included in the file named DDE.TXT, 
contained in your QuickVerse directory. If you want to customize your word processor to use DDE to "talk 
to" QuickVerse, please refer to that file for detailed technical information. 

If you use Word for Windows version 6.0, Ami Pro version 3, or WordPerfect 6.0a you may want to use 
some macros we have supplied for these word processors. The macros will be installed in a subdirectory 
called Macros within your QVWIN program directory. The files are as follows: 

PARSONS.DOT--A Word for Windows template file. Open this file in Word to view additional 
instructions. 

PARSONS.SMM--An Ami Pro macro file.

AMIPRO.SAM--An Ami Pro document file containing instructions for using the macro. Open this 
file to view additional instructions. 

WORDPERF.EXE--A compressed file containing the macro file PARSONS.WPT and the 
document file PARSONS.WP6. Decompress the file by running the executable file 
WORDPERF.EXE. Then open the document file PARSONS.WP6 in your word processor to view 
additional instructions. Note that if you use QuickVerse on CD-ROM, you will not need to 
decompress these files.

These macros were created by three of our beta testers, and not by Parsons Technology. We supply them 
with QuickVerse as a service to you. Please keep in mind that while our technical support staff is eager 
to help you with QuickVerse and other Parsons Technology products, they are NOT trained in the use of 
the word processors you may be using to run these macros. 

NOTE: If you need assistance using these macro files, you can send your questions via 
CompuServe directly to the authors of these macros.

For questions on:
Microsoft Word macro files, contact Mike Hartford via CompuServe at 70243,574.
Ami Pro macro files, contact Steve Blendermann via CompuServe at 70650,2624.
WordPerfect macro files, contact Dale Durnell via CompuServe at 70461,1201.



Additional word processor macros may be supplied. If so, the README.TXT file in your QuickVerse 
directory will contain more information. 



Dialog Box

A bordered area displayed on screen to relay a message, report an error, 
confirm an action, receive an entry, or display program features.



Display Options

 Choose Display from the Options menu to customize the appearance of your QuickVerse screen. In the 
Display Options dialog box that opens, you can specify the settings you'd like to use for the display of text 
in Bible and Note windows. Click OK in the Display Options Dialog when you've made your selections, or 
use Cancel to abandon any changes.

Choose from the topics below:
Font Styles and Colors 
Hebrew and Greek Word Format 
Other Display Options 



Directories

 The Directories feature on the Options menu lets you set the default directory path for your text, note, 
and index files. QuickVerse automatically saves these files in the directory where you installed 
QuickVerse. However, you can change these directories at any time. For example, if you keep word 
processing files in C:\WP, you may also want to put your QuickVerse text files there. Select Directories 
from the Options menu. The Directory Options dialog box appears. Type the directory path in the 
appropriate field(s) and click OK. 

See also:
Using Notes 
Using Indexes 
Using Text Files 



Translations

 With QuickVerse, you have the option of installing additional translations to expand your selection of 
Bible versions. The Translations feature on the Options menu displays a table of all translations available 
with QuickVerse. When you install a translation, an X appears in the Installed field box beside the 
translation. QuickVerse automatically keeps track of the translations you install. You will rarely need to 
modify this table; by default, QuickVerse automatically maintains it.

Under some circumstances, you may need to change the directory for a translation. For instance, you 
may decide to move QuickVerse files to a different drive or directory after you install them. If you do, you 
must also change the directory path to let the program know where to find the files. To specify the 
directory for a translation:

1. Select Translations from the Options menu. The Translation Options dialog box appears.

2. If the directory of a translation is wrong, change the directory path by typing over the existing 
entry in the Directory field.

3. Click the OK button.

You can also change the Description field of the translations. However, we recommend that you do not 
change the Name field.

See also:
QuickVerse   Add-on Modules   
Opening Multiple Translations 



Arranging the Desktop

You can arrange the QuickVerse desktop to suit your needs. Then save the changes or restore the 
desktop to its previous configuration.

Save Desktop--You can save your desktop so it opens with specific translations or even at a particular 
verse in a translation. For example, if you do much of your work in the New Testament, you may want 
QuickVerse to open to Matthew 1:1. Or perhaps you are in the middle of a Bible study and need to exit 
QuickVerse. In both cases, you'll want to save your desktop. When you return to the program, you begin 
where you left off.

The Save Desktop option saves the open windows and their contents, but it does NOT save what is 
considered configuration information such as font, point size, and display setups. These items are all 
saved in one of the program's configuration files and are automatically saved when you click the OK 
button from their respective dialogs. You can save your desktop in several ways:

* Select the Options menu and choose Save Desktop. Answer OK when asked if you want to 
replace the desktop.

* Double-click on the Control Menu box in the upper left corner of the window or choose Exit 
QuickVerse from the File menu. Click the Save Desktop box. (NOTE:    This option is only 
available if you've marked the Display exit prompt setting in the Display Options dialog box.)

Restore Desktop--If you change your desktop setting temporarily, it's easy to restore it to the previous 
setup. To restore your desktop, select the Options menu and choose Restore Desktop. Answer OK when 
asked if you want to replace the current Bible windows with the startup desktop.

Icon Bar--By default, QuickVerse shows the icon bar. You can toggle the icon bar off and on again by 
clicking the Icon Bar option in the Options menu. When the icon bar is displayed, a check mark appears 
next to the command. 

Status Bar--QuickVerse also displays the status bar by default. You can toggle the status bar off and on 
again by clicking the Status Bar option in the Options menu. If the status bar is on, a check mark appears 
next to the command. 



Font and Color Selection

Use the Fonts menu to select the font and point size for text on your screen and that you print. You can 
also select the color for words of Christ, verse references, and search words.

Bible Font--Select this option from the Fonts menu and choose Display or Print from its submenu to 
select the font and point size of text that appears in a Bible window and that you print from a Bible 
window. 

Note Font--Select this option from the Fonts menu and choose Display or Print from its submenu to 
select the font and point size of text that appears in a Note window and that you print from the Note 
window. 

Search List Font--Select this option from the Fonts menu to select the font and size you would like to 
use for the verse text in the Search List. This font also applies to your Note and Index List windows.

Colors--Select this option from the Fonts menu to select the color for the words of Christ, search 
words, and verse references. As you select the colors you would like to use, you'll see the sample text 
at the bottom of the Colors dialog change to reflect your choices. Note:    To enable the colors you 
select, you must also mark the corresponding items in the Display Options dialog. For 
example, if you select Teal for the color of search words, you must also mark the "Use color for 
search words" check box in the Display Options dialog in order for the search words to appear in the 
selected color. Open the Display Options dialog by choosing Display from the Options menu.

You can also apply boldface, italics, and underlining to your note text using the Fonts menu. With your 
cursor placed in a note window, choose the style you'd like to use from the Fonts menu and begin typing. 
The text you type will appear in the selected format. To return to typing in normal text, select the option 
again from the Fonts menu to toggle it off. (A check mark next to the option appears when it is in use and 
will disappear when you deselect the option.) You can apply formatting to notes you've already typed by 
highlighting a word or phrase in the note and selecting the format you want to use from the Fonts menu. 
The format will be applied only to the highlighted portion of the note. You can use the formats individually 
or in combination. 

Use the pop-up menu containing these note formats to have quick access to these options. With your 
mouse placed in a Note window, click the right mouse button to open the pop-up menu and select an 
option. 

Note that the format of verse references (cross references) in the note window cannot be 
modified.

NOTE: In order to have the boldface, italics, and underlining appear in text you paste to 
a word processing document, you must set up the clipboard to recognize the formats 
and use Copy Formatted when copying the text. 



Using Other Applications with QuickVerse

Use the Other Applications selection from the Options menu to open a dialog in which you can enter the 
path to the directory containing your Bible atlas, Bible dictionary, topical Bible, or Bible library, so you can 
access them from within QuickVerse.

The first four fields in the Other Applications dialog allow you to indicate the location of your other Bible 
related programs. Enter the paths to your Bible atlas program, such as PC Bible Atlas from Parsons 
Technology, Bible dictionary program, such as Holman Bible Dictionary, Bible library program, such as 
The QuickVerse Library, or Bible Illustrator for Windows. If you have these programs (or programs 
compatible with them) indicating the path to their location allows you to use the Search menu to open 
them from within QuickVerse. 

The last field in the Other Applications dialog allows you to specify the directory containing Nave's 
Topical Bible, if you've installed this add-on module for QuickVerse. This allows you to run Nave's from 
another drive or directory. Enter the complete path and name of the data file. For example, you might 
enter C:\QVWIN\NAVES.DAT. 

Mark the Synchronize QuickVerse Library reference books check box if you have purchased The 
QuickVerse Library and you want articles in the library to scroll as you move to various verses in 
QuickVerse. For example, when this check box is marked and you move from John 3:16 to John 3:17 in 
QuickVerse, the library will scroll its books to an article related to John 3:17.



Font Styles and Colors

Use this category of selections in the Display Options dialog to enable the use of color, boldface, italics, 
and underlining in your Bible and Note text. With these options enabled, you may apply these text formats 
to your note text for emphasis or clarity. Also, the formats will be applied to selected words in the Bible's 
text when you have these options marked. 

Choose from these options:

Enable boldface--Allows you to use boldface for text you enter in Note windows. The boldface option 
is found on the Fonts menu.

Enable italics--Causes words inserted for clarity by the translators to appear in italics. Marking this 
option also allows you to use the Italics option on the Fonts menu for text you type in Note windows.

Enable underline--Allows you to use the Underline option on the Fonts menu to add clarity and 
emphasis to your Note text. 

Use color for the words of Christ--Allows you to designate a color for the words of Christ in the 
Bible text window. Once you've marked this option, select a color by choosing Colors from the Fonts 
menu. 

Use color for verse references--Allows you to assign a color for verse references appearing in the 
Bible text and Note windows. After marking this box, select a verse reference color by choosing 
Colors from the Fonts menu. 

Use color for search words--Causes search words to appear in a color you designate. Once you've 
marked this option, select the color by choosing Colors from the Fonts menu.



Hebrew and Greek Word Format

 If you have purchased and installed a concordance, such as Strong's Concordance, you may use these 
options in the Display Options dialog to set up the display of the text in that translation. Selecting 
Numbers will display the Strong's number only, Words will display the Hebrew/Greek word only, and Both 
will display the word followed by its number. Open the Display Options dialog by choosing Display from 
the Options menu.

See also:
Using a Concordance 



Other Display Options

 
Open the Display Options dialog by choosing Display from the Options menu. Use the selections in the 
Other Options section of the dialog to:

Display full book, chapter, and verse references in the Bible text window. If you do not mark this 
option, book names will appear only with the first verse in the book and chapter numbers will appear only 
with the first verse in each chapter. All other verses will be labeled with their numbers only.

Automatically close the verse list window when viewing a verse. Marking this option closes the list 
window after you view a verse from a Search List, Note List, or Index List window.

Display exit prompt. Marking this option will display the Exit   QuickVerse   dialog box each time you exit 
the program for you to confirm that you wish to end your session.



Formatting Notes

You can select items from the Fonts menu to set up the display of your note text to suit your needs. The 
Fonts menu allows you to have a different font for your notes than you do for your Bible display. Also, you 
can set a font to use for text you print, so you can set your notes apart from the Bible text when printing 
verses and notes together. 

Select the font by choosing Note Font from the Fonts menu. Then select Display if you would like to 
modify the appearance of the note text on your screen, or select Printer if you would like to change the 
font of the notes you send to the Printer. Either selection you make will open a Font dialog in which you 
can select the name of the font and the point size for the type. (You can get a preview of the selections 
you make in the Sample box in the QuickVerse Fonts dialog.) Click OK when you've made your 
selections. Text in your Note windows will change to reflect the new selections. 

Additional options on the Fonts menu allow you to bold, italicize, or underline text in your notes. Highlight 
the word(s) in the note that you wish to format, and select the desired option from the Fonts menu. Or, 
simply press the right mouse button when your mouse is located in a Note window to pop up a menu and 
select the option you want to use. The pop-up menu contains editing and format commands which 
provides quick access to these functions. The formats you assign will also print with your notes if you 
configure QuickVerse to include italics, underline, and boldface in the Print Setup dialog. 

See also:
Printing Notes with Verses 



Clipboard

A temporary storage location used to transfer data between documents and 
applications.



The Clipboard Setup Dialog Box

QuickVerse gives you the capability of setting up the appearance of the verses you paste to a word 
processor. 

*    Open the Clipboard Setup dialog box by choosing Clipboard Setup from the Edit menu. Use this 
dialog to indicate the options you would like to use for verses you copy to the clipboard for 
pasting into a word processor.

When you've opened the setup dialog, click on the style you would like to use for the verse and its 
reference. The Verse Format options available are described below.

Reference Verse--Reference will precede the verse's text--for example, 
(1 Th 5:16 KJV) Rejoice evermore.

Verse Reference--Reference will follow the verse's text--for example, 
Rejoice evermore (1 Th 5:16 KJV).

Separate line--Verse will be pasted on a line below its reference--for example, 
1 Th 5:16 (KJV)
Rejoice evermore. 

Verse Only--Only the verse text will appear--for example, Rejoice evermore.

Reference only--Only the verse's reference will appear--for example,
1 Th 5:16 KJV. 

Paragraph style--Consecutive verses will be pasted directly after one another with each verse reference 
embedded in the text. The reference will be surrounded by the delimiting characters you specify to set it 
apart from the textfor example ...all men. {16} Rejoice evermore...

For more information on the clipboard setup options, see:
Delimiters 
More Verse Format Options 



Pasting to a Word Processor

 When your clipboard options are set up to suit your needs, you're ready to copy and paste using the 
other features on the Edit menu. Select the verse or verses you wish to paste by clicking and dragging to 
highlight them. (If you plan to use Copy Formatted, it is not necessary to highlight the entire verse--
portions of verses that are highlighted are completely included automatically when you perform the copy 
and paste functions.) Then select Copy or Copy Formatted from the Edit menu and switch to your 
Windows word processor. Select paste from the word processor's Edit menu and the text you selected will 
be pasted in the format you specified in the Clipboard Setup dialog. 

NOTE:    Use the Copy option on the Edit menu to copy exactly what is highlighted (i.e. 
the entire verse will not be copied if only a portion of it is highlighted). The Copy 
command will not recognize the verse formatting options you specified in the Clipboard 
Setup dialog. The verses you paste will appear in Normal text. You need to select Copy 
Formatted in order to apply the special formats to the verses you paste. 

See also:
Setup Options 



Copying Passages

The Copy Passage command on the Edit menu offers a quick way to select a passage to copy. When you 
select Copy Passage, a dialog opens for you to enter the reference range and translation you would like 
to copy (note that you must have other translations installed in order to copy from them). Indicate the 
range of verses by typing the book, chapter and verse of the beginning and end of the passage. You may 
abbreviate book names if you supply enough letters to distinguish them from other books. For example, 
you might enter John 3:16; Eph 2:8-9. You can also replace colons with periods in the reference if you 
prefer. Click OK when you've entered the passage you wish to copy, and it will be copied to the clipboard 
ready for you to paste into your word processor. This option will recognize the Clipboard Setup options 
you've defined for pasting. 

NOTE:    If you establish a link from QuickVerse to your word processor, you'll also be 
using this dialog to paste verses from within your word processing program. See Word 
Processor Customization for details.

See also:
Edit Menu



Word Processor Customization

The QuickVerse Word Processor Customization feature provides another way to import QuickVerse 
Bible text into word processors (or other application programs) that do not support DDE. This feature 
works for many Windows applications containing an Edit menu with a Paste command. As with DDE, 
Word Processor Customization is the equivalent of copying verses to the Windows Clipboard from 
QuickVerse and then pasting them into word processor documents, but the direct link allows you to 
perform the entire process from your word processor. Once you set up this option in QuickVerse, the only 
stipulation is that QuickVerse must be open before you access it from your word processor.

This process requires three main steps:

1. Setting Up Word Processor Customization

2. Creating the Link

3. Accessing   QuickVerse   from Your Word Processor  



Opening and Creating Files

 QuickVerse allows you to create text files which you can open and use in a word processor. Before you 
can place verses in a file, you must open or create a file. 

To create a new file:

1. Choose Open File from the File menu. The Open File dialog box appears.

2. Verify the directory in which you want to place the file. By default, the program uses the 
QuickVerse directory (for example, C:\QVWIN), but you can choose another directory. You can 
configure QuickVerse to access the new directory automatically. See Directories for more 
information.

3. Type the name of the new file in the Text File field and click OK. File names consist of eight or 
fewer characters for the name, a period, and a three-character extension. It is customary to use 
the extension .TXT for text files, but QuickVerse will let you enter any file name you desire.

4. The system displays a message asking if you want to create the new file. Click Yes. The file 
opens, and you'll see the file's name indicated in the status bar of the QuickVerse window. Once 
a file is open, you can save verses to it.

To open an existing file:

* Choose Open File from the File menu and find the file name in the Files list in the Open File 
Dialog box. If you have stored your text files in a directory other than QuickVerse, double-click on 
the directory to display its files. Select the file and click OK.

Notice that the name of the open file is displayed on the status bar on the bottom of the QuickVerse 
Desktop.

See also:
Adding Verses to Files 
Setting File Options 
Using Files 



Setting File Options

 Once you've opened or created a file, you may want to define some file options before placing verses in 
it to make use of the numerous automatic formatting options available in QuickVerse. Choose File Setup 
from the File menu to open the File Setup dialog box. This dialog allows you to specify the verse format, 
file margins, whether to include book and translation names for verses, notes attached to inserted verses, 
and whether you want quotations to appear around verses. Click OK when you've chosen all the options 
you wish to use. You can open the dialog again at any time and adjust your selections.

Choose from the following topics to learn more about setting up files:
Verse Format 
Margins 
More Setup Options

See also:
Saving Verses to a File 



Closing Files

 QuickVerse automatically closes and saves your text files when you exit the program. If you are working 
on a text file and open a second one, QuickVerse closes the first file. If you want to close a file manually, 
select Close File from the File menu. 

After you create and save a file, import it into your word processor to create your sermon or Bible study. 
Refer to your word processor documentation for details on importing ASCII files. 



Print Setup

 With Print Setup you can indicate how QuickVerse prints verses. You can choose the verse format, 
margins, and other options to ensure your printed output appears just the way you want. To use Print 
Setup, select Print Setup from the Print menu. In the Printer Setup dialog box that appears, click the 
button beside the Verse Format option you want to use for printed verses. 

In the Printer Setup dialog, specify the left and right verse margins in inches. Type the top and bottom 
margins in inches. If you include your notes with verses, type the left and right margins of the notes, also 
in inches. You may want to indent your notes to distinguish them from the printed verses and make them 
easier to read. Click the OK button when you've completed the setup.

To select the desired font and point size of the printed text, select Bible Font or Note Font from the Fonts 
menu to select the font for Bible and note text; then choose Printer to open a font selection dialog. 
Choose the font and point size of the Bible and note text to cause the output to appear in the selected 
format.



Using Bible Illustrator with QuickVerse

 Bible Illustrator can be activated or searched by selecting Bible Illustrator from the Search menu. This 
menu item acts differently depending on whether or not any text is selected in the active Bible window. If 
no text is selected, then this menu item simply activates (or switches to) Bible Illustrator. However, if text 
is highlighted, selecting this menu item will not only switch to the program, but also ask it to search for the 
selected text. For instance, if you highlight the word "faith" in either the Bible text window or in a Note 
window, selecting Bible Illustrator from the Search menu will cause the program to open and search for 
"faith." 



Nave's Topical Bible

 Nave's Topical Bible organizes the Bible by topic, allowing you to search over 20,000 topics and 
subtopics. If you've purchased Nave's, you'll find it a useful addition to QuickVerse. Use Nave's by itself 
in a search or in combination with other search options. You can add your own topics to Nave's, modify 
existing topics, or change the references cited under a topic.

Click on a topic below to learn how to:
Access   Nave's   
Search with   Nave's   
Create New   Nave's   Topics and Subtopics   
Modify Topics and Subtopics 
Delete Topics and Subtopics 
Copy   Nave's   Topics   



Using a Concordance

 Concordances, such as Strong's Concordance and the New American Standard Exhaustive 
Concordance (NASC) are add-on modules for use with QuickVerse. Strong's Concordance is 
intended to be used as a guide for studying the Scriptures as they were written in their original languages. 
The NASC, although not an original language Bible, provides insight into the original languages used to 
prepare the New American Standard Bible. 

Strong's Concordance is based on "Strong's Exhaustive Concordance of the Bible." The text contains 
transliterated Hebrew or Greek words that are spelled phonetically with English characters (that is, NOT 
Hebrew or Greek characters). The word order of the transliteration is based on the King James Version.

The NASC is based on the "New American Standard Exhaustive Concordance of the Bible." It also 
contains transliterated Hebrew and Greek words. The word order of the transliteration is based on the 
New American Standard Bible.

If you've installed the Strong's Concordance or the NASC, you'll also have access to the corresponding 
Hebrew and Greek Dictionary option on the QuickVerse Windows menu. This dictionary is used when 
you perform a KJV or NASB Word Study.

For more information on using concordances, see: 
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
KJV Word Study 
NASB Word Study 
The Dictionary Definition Window 
Searching a Concordance
Using a Concordance Dictionary
Signs Employed in the Greek 
Signs Employed in the Hebrew
Symbol List--Hebrew Bible 
Symbol List--Greek Bible 
Hebrew and Greek Word Format 



Creating New Nave's Topics and Subtopics

QuickVerse gives you the flexibility to add new Nave's topics and subtopics or modify existing ones, 
making it easy to customize Nave's to suit your needs. For instance, you might add the subtopic love to 
the topic marriage. If you want to add verses to a topic or subtopic, you must first create an index file 
containing the verses.

To create new topic and subtopic entries in Nave's:

1. Create a QuickVerse index file containing the verses for your new topic.

2. Click the Search icon to display the Search dialog box.

3. Place your cursor in the Nave's field and click the Topic List button. The Nave's Topical Bible 
dialog box appears.

4. Highlight the place where you want to insert the new topic. The new topic will appear below the 
one you highlight.

5. Select Insert from the Edit menu to open the Insert Nave's Topic dialog. 

6. Type the name of the topic you want in the Topic field.

7. Choose one of the following:

* Same. QuickVerse places the topic on the same outline level as the highlighted topic. If the 
highlighted topic is a main topic, QuickVerse places the new entry in alphabetical order 
regardless of which topic is highlighted. For example, if you highlight Abraham and try to insert 
Sarah, QuickVerse inserts the new topic alphabetically within the S section.

* Next. QuickVerse places the topic on the next lower outline level and immediately following the 
highlighted topic.

8. Define the verses associated with the new topic. Choose one of the following:

* None. By convention, no verses are assigned to any entry that has subentries. However, you can 
assign verses if you want.

* Use index file. Assign verses from an index file. Scroll through the Directories and Files lists to 
locate the correct index file and highlight it.

9. Click the OK button. QuickVerse inserts the new topic entry.

See also:
Creating Cross References in   Nave's   



Modifying Nave's Topics and Subtopics

You can change the name of a topic or subtopic, add new verses, replace existing verses with those in 
the current index, or delete all verses associated with the topic. To add verses, first create an index file 
containing them. To modify Nave's topics and subtopics:

1. Click the Search icon to display the Search dialog box.

2. Place your cursor in the Nave's field and click the Topic List button. The Nave's Topical Bible 
dialog box appears.

3. Highlight the topic you want to change.

4. Select Modify from the Edit menu to open the Modify Nave's Topic dialog.

5. If you want to change the topic name, type the new name in the Topic field. If you change the 
name of a main topic, QuickVerse places the topic and its subtopics in alphabetical order.

6. To modify verses associated with the topic, choose one:

* No change. Doesn't change the verses.

* ADD from Index. Adds verses from the index you specify to existing verses of the topic. Existing 
verses in the topic are not affected.

* REPLACE from index. Replaces current verses associated with the topic with verses from the 
index you specify. Existing verses are lost. 

* None for this topic. Deletes any verses associated with a topic.

7. Click the OK button. QuickVerse modifies the topic entry.

See also:
Searching with   Nave's   
Creating New   Nave's   Topics and Subtopics   
Copying   Nave's   Topics   



Deleting Nave's Topics and Subtopics

In addition to adding to and modifying Nave's topics, you can also delete topics and subtopics. For 
example, you might delete a topic or subtopic you created if the information isn't useful anymore. If you 
delete a topic with subtopics beneath it, all of the subtopics are also deleted.

Deleting topics and subtopics doesn't make the Nave's file smaller. The program maintains a record of 
deleted space in the file and reuses it as you add or modify entries. To delete Nave's topics and 
subtopics:

1. Click the Search icon to display the Search dialog box.

2. Place your cursor in the Nave's field and click the Topic List button. The Nave's Topical Bible 
dialog box appears.

3. Highlight the topic you want to delete.

4. Select Delete from the Edit menu. QuickVerse displays a message asking you to verify the 
deletion. (Remember, if you delete a topic with subtopics, all of the subtopics are also deleted.)

5. Click the Yes button to delete the topic or subtopic, or click the No button to cancel the deletion.

See also:
Searching with   Nave's   
Creating New   Nave's   Topics and Subtopics   
Modifying Topics and Subtopics 
Copying   Nave's   Topics   



Copying Nave's Topics

You can file, index, or print sections of the Nave's outline or copy them to the clipboard. To do this: 

1. Click the Search icon to display the Search dialog box.

2. Place your cursor in the Nave's field and click the Topic List button. The Nave's Topical Bible 
dialog box appears.

3. Highlight the topic or subtopic you want.

4. Click Copy To. The Nave's Topical Bible: Copy To dialog opens. Indicate the destination for the 
selected item. Choose one: 

* Clipboard. Copies the topic and any subtopics to the clipboard. See Clipboard Setup for more 
information.

* File. QuickVerse copies the topic and subtopics to the current file. Remember, you can configure 
the file format in which QuickVerse saves the verses. See Setting File Options for details.

* Index. QuickVerse copies the verses from the topic and any subtopics you indicate to the current 
index.

* Printer. QuickVerse sends the topic or subtopic to a printer. To configure how QuickVerse prints 
the verses, see Print Setup.

See also:
Searching with   Nave's   
Creating New   Nave's   Topics and Subtopics   
Modifying Topics and Subtopics 
Deleting Topics and Subtopics 



Creating Cross References in Nave's

Reference other Nave's entries that pertain to a newly-created topic by inserting see cross-references. 
Simply create a new subtopic. The format for the cross-reference is:

See TOPIC|subtopic|subtopic....

Vertical bars separate each subtopic; so to create a cross-reference to the entry, Called AHIMELECH 
below:

ABIATHAR

1. High Priest

        Called AHIMELECH

        Called ABIMELECH

the proper entry would be:

See ABIATHAR|1. High Priest|Called AHIMELECH

See also:
Searching with   Nave's   
Modifying Topics and Subtopics 
Deleting Topics and Subtopics 
Copying   Nave's   Topics   



Viewing a Concordance

 Use the same QuickVerse commands that open any Bible translation to open a concordance such as 
Strong's Concordance. 

1. Select Open Bible from the Windows menu.

2. Select the Strong's Concordance or the NASC and press click OK. (Note: You must install these 
QuickVerse add-on modules before you can open them.) 

A new Bible window will be opened to contain the transliterated Bible text and the definition window. The 
text in the Bible window contains transliterated Hebrew or Greek words displayed in a format similar to the 
English texts. 

The word order of Strong's transliteration is based upon the word order in the King James Version. (The 
NASC is based on the NASB.) For example the KJV text for Genesis 1:1 reads:

In the beginning God created the heaven and the earth.

In the transliterated Hebrew, it reads:

re'shiyth 'elohiym bara'. shamayim . . 'erets. 

You can customize the display of the Hebrew/Greek translation window to show the Strong's number the 
word in the original language, or both. To do so, choose display from the Options menu. Click the 
"Numbers," "Words," or "Both" option in the Hebrew and Greek Word Format section of the Display 
Options dialog box.

For more details on using a Concordance, see: 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
The Dictionary Definition Window 
Searching a     Concordance   
Using a Dictionary 



Tips for Using Strong's Concordance

 See the following topics for tips on using Strong's Concordance:
Words Not Included in Concordances 
Symbols Used in Concordances 
Duplicated Words in Concordances 
Errors in   Strong's Concordance   
Symbols in   Strong's   Greek Bible   
Symbols in Strong's Hebrew Bible 
Signs Employed in Strong's Greek 
Signs Employed in Strong's Hebrew 



The Dictionary Definition Window

 When you open a concordance such as Strong's or the NASC to view the Hebrew/Greek translation (or 
transliterated Hebrew/Greek text), the corresponding dictionary automatically appears in a definition 
window (HG.DCT or NASC.DCT) below the translation. The definition of the (highlighted) Hebrew or 
Greek word appears in this window. 

The definition window is like a note file; you can add, change, or delete entries at any time. When you 
change the definition of a word in one verse, the new definition applies to each occurrence of the word in 
the Bible.

Before making any changes, first consider that if an update to the concordance is ever issued, any 
changes you have made to your copy of the file will not be carried into the updated version.

NOTE:    The NASC dictionary is installed as a READ ONLY mode to prevent you from 
making any accidental changes. If you wish to edit the definitions, you must first change 
the file's attributes. To do so, open your Windows File Manager and locate the 
NASC.DCT file. (Assuming you didn't change default directories, the file will be under 
the NASC subdirectory of your QuickVerse (QVWIN) directory.) Highlight the NASC.DCT 
file, then select Properties from the File menu of the File Manager. In the Attributes 
dialog that appears, click on the Read Only check box to remove the check mark. Now 
you can make changes to the dictionary.

To edit a definition in the Definition window, 

1. Highlight the word you want. The definition appears. 

2. Click your cursor in the note window or select Write Note from the Notes menu to make the Note 
window active. 

3. Your cursor appears in the definition window and you can change the definition as necessary. You 
can use the Edit menu functions to modify the text as you wish. 

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
Searching a Concordance 
Using a Concordance Dictionary 
The Hebrew and Greek Word List 



Searching a Concordance

 To perform a search of a concordance, such as Strong's Concordance, you must first open the 
concordance by choosing Open Bible from the Windows menu and selecting the concordance as the 
Bible option. Once the transliteration is open and the Bible window containing Strong's is active, choose 
Search from the Search menu. Then complete the Phrase field by entering one of the following:

* Type the Hebrew or Greek word. For example, enter agape (agapay in the NASC). If you 
search for a word without its Strong's number, QuickVerse finds all words spelled the same, 
regardless of the number. For example, if you searched for 'abad, QuickVerse finds H5647, 
H5648, H5649, H565, H6, and H7.

* Type the Strong's number. An H (Hebrew) or G (Greek) must precede the number, for instance 
G26.

* Type both the word and number. Separate the two with a colon, such as agape:G26.

* Use the Word List.With the cursor in the Phrase field click the Word List button to display all the 
Hebrew and Greek words in the Bible. Use the arrow keys to scroll through the list or type the first 
few letters of your selection. Press Enter to select a word and return to the Search window. The 
word you selected appears in the Phrase field.

* Use a wild card. Type the first few characters of the word and/or Strong's number followed by an 
asterisk (*). Wild card searches let you generate a list of all verses beginning with the Strong's 
number or containing words beginning with those letters. For example, type 'el:H4* to find all 'el 
words that have a Strong's number starting with 4 (410, 411, etc.). If you type el*, QuickVerse 
finds all words that start with the letters el, regardless of the Strong's number.

Once you've completed the Phrase field, click Search. QuickVerse displays a Search list window of all 
the verses containing the word or phrase you specified.

For more information, see:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the NASC 
The Dictionary Definition Window 
Using a Dictionary 
The Hebrew and Greek Word List 



Using a Concordance Dictionary

 When you're using a Hebrew and Greek transliterated Bible, such as Strong's Concordance, you'll find 
the corresponding Dictionary option from the Windows menu to be useful in your study. 

The dictionary is especially valuable when you want to look up cross references mentioned in the 
definition of a Hebrew or Greek word that you've highlighted in the concordance window. Often the cross 
references to another Hebrew/Greek word is indicated by a number rather than its spelling. 

To access the word and definition that corresponds to a Strong's number, you can use the Strong's 
Dictionary (or the NAS Concordance Dictionary, if you're working with the NASC). Instructions for both 
options follow.

To use the Strong's Dictionary Window,

1. Select Strong's Dictionary from the Windows menu to display the Strong's Dictionary Window. 

2. Type the Strong's number of interest into the Strong's Number field. Preface the number with an 
"H" to indicate the number is a Hebrew word (H1024), or a "G" to indicate the number is a Greek 
word (G1024). 

3. Press Enter to view the definition. If the definition is too large to be completely displayed, you can 
use the up and down arrow keys to scroll it in the window.

4. Once the definition is displayed, press the Copy To button to transfer the definition to the open 
text or index file, to the printer, or to the Windows Clipboard. 

5. In the Copy To dialog, select the items and their destination by clicking on the options you want. 
The note margins specified in the file or print setup dialog, will be used if you choose one to copy 
the definition to a file or printer. 

6. Click OK.

In addition to the Copy To button, you can use other buttons when you're working in the Strong's 
Dictionary Window. Click on any of the buttons in the illustration below for more information.



To use the NASC Dictionary window,

NOTE:    With the NASC, most cross references in the Definition (note) window are 
linked text. Clicking on any of these highlighted Strong's Numbers will automatically 
open the NASC Dictionary to the definition of the Greek or Hebrew word referenced by 
the number.

To open the NASC Dictionary window manually and use it,

1. Select the NASC Dictionary from the Windows menu to display the NASC Dictionary Window. 

2. Type the Strong's number of interest into the Strong's Number field. Preface the number with an 
"H" to indicate the number is a Hebrew word (H1024), or a "G" to indicate the number is a Greek 
word (G1024). 

Since the NASC includes more words than Strong's, some of the NASC words also have a letter 
suffix (a, b, c, etc.). Include this suffix, if necessary.

3. Follow steps 3 through 6 for using the Strong's Dictionary.

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
The Dictionary Definition Window 
Searching a     Concordance   



Words Not Included in Concordances

 Not every word in the King James Version has a corresponding Hebrew or Greek word. Periods (.) in the 
definition show the positions of words that are not included in Strong's Concordance. For example, 47 
words, such as articles and prepositions (for example, and, from, them), are excluded from Strong's 
Exhaustive Concordance. (This method is also used in the NASC.)

As an example, the first word of Genesis in Hebrew is actually b'reshiyth, but Strong's transliteration 
removes the preposition b', leaving only the root word, re'shiyth. The ellipsis is indicated in the text by a 
period. Nor does the article "the" have a corresponding Hebrew article in the text, but was necessary for 
the translation, so its lack of a Hebrew counterpart is also indicated by a period. 

The same principle applies the particle et, which indicates the direct object in a sentence and has no 
English counterpart, and to the Hebrew word shamayim, which in the original Hebrew text begins with the 
article ha'. Strong's lists only the root word shamayim (in its plural form). In Hebrew, most prepositions, 
articles, and conjunctions are attached to words as prefixes or suffixes. Strong's omits them in order to 
show the root word.

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
The Dictionary Definition Window 
Searching a     Concordance   
Using Strong's Dictionary 



Symbols Used in Concordances

 A dash (-) between two Hebrew or Greek words indicates that both words are translated into one word in 
the King James Version. For example, in Galatians 6:7, hos - ean is translated into "whatsoever." Note 
that dashes are separated by spaces from the Hebrew or Greek words. This distinguishes them from 
hyphens (for example, bath-sheba), which are part of the spelling and indicate one word.

This method is also employed in the New American Standard Bible which translates hos - ean as 
whatever.

Underscores (_) in the Hebrew and Greek text join two or more words identified by one Strong's number. 
For instance, in abed_negow in the Hebrew and Greek definition window is abed negow in Strong's 
Exhaustive Concordance.

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
Symbol List--Hebrew Bible 
Symbol List--Greek Bible 



Duplicated Words in Concordances

 You may run across a Hebrew or Greek verse with duplicated words. This repetition is based on 
"Strong's Exhaustive Concordance," which references consecutive English words in a verse with the 
same Strong's number. For instance, look at Romans 1:31 (KJV): Without understanding, covenant 
breakers, without natural affection, implacable, unmerciful:. In the definition window, without and 
understanding are each translated as asunetos:G801.

Although the sample verse is translated differently in the New American Standard Bible, the duplication is 
the same, since the NASC also uses Strong's numbers.

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
The Dictionary Definition Window 
Searching a     Concordance   
Using a Dictionary 



Errors in Strong's Concordance

 Although errors are rare, you may find an incorrectly translated word in the transliteration. This is 
because the transliterated Bible is based on "Strong's Exhaustive Concordance," which may contain 
typographical errors. We have corrected literally thousands of the errors which occur in every printed copy 
of "Strong's Exhaustive Concordance." However, write and let us know if you find an additional one. It is 
our goal to ensure the highest degree of accuracy in the translation of Hebrew and Greek words.

See also:
Viewing a Concordance 
Tips for Using   Strong's Concordance   
Tips for Using the   NASC   
The Dictionary Definition Window 
Searching a     Concordance   
Using a Dictionary 



Symbol List--Strong's Hebrew Bible

 Following is a list of the abbreviations and symbols from Strong's Dictionary of the Words in the Hebrew 
Bible:

abb. = abbreviated, abbreviation
absol. = absolute, absolutely
abstr. = abstract, abstractly
act. = active, actively
adj. = adjective, adjectively
adv. = adverb, adverbial, adverbially
aff. = affix, affixed
affin. = affinity
appar. = apparent, apparently
arch. = architecture, architectural, architecturally
art. = article
artif. = artificial, artificially
Ass. = Assyrian
A.V. = Authorized Version
Bab. = Babylon, Babylonia, Babylonian
caus. = causative, causatively
Chald. = Chaldaism, Chaldee
collat. = collateral, collaterally
collect. = collective, collectively
comp. = compare, comparative, comparatively, comparison
concr. = concrete, concretely
conjec. = conjecture, conjectural, conjecturally
conjug. = conjugation, conjugational, conjugationally
conjunc. = conjunction, conjunctional, conjunctionally
constr. = construct, construction, constructive, constructively
contr. = contracted, contraction
correl. = correlated, correlation, correlative, correlatively
corresp. = corresponding, correspondingly
def. = definite, definitely
denom. = denominative, denominatively
der. = derivation, derivative, derivatively
desc. = descendant, descendants
E. = East, Eastern
e.g. = exempli gratia, for example
Eg. = Egypt, Egyptian, Egyptians
ellip. = ellipsis, elliptical, elliptically
equiv. = equivalent, equivalently
err. = erroneous, erroneously, error
esp. = especial, especially
etym. = etymology, etymological,    etymologically
euphem. = euphemism, euphemistic, euphemistically
euphon. = euphonically, euphonious
extern. = external, externally
infer. = inference, inferential, inferentially
fem. = feminine



fig. = figurative, figuratively
for. = foreign, foreigner
freq. = frequentative, frequentatively
fut. = future
gen. = general, generally, generical, generically
Gr. = Graecism, Greek
gut. = guttural
Heb. = Hebraism, Hebrew
i.e. = id est, that is
ident. = identical, identically
immed. = immediate, immediately
imper. = imperative, imperatively
impl. = implication, implied, impliedly
incept. = inceptive, inceptively
incl. = including, inclusive, inclusively
indef. = indefinite, indefinitely
infin. = infinitive
inhab. = inhabitant, inhabitants
ins. = inserted
intens. = intensive, intensively
intern. = internal, internally
interj. = interjection, interjectional, interjectionally
intr. = intransitive, intransitively
Isr. = Israelite, Israelites, Israelitish
Jerus. = Jerusalem
Levit. = Levitical, Levitically
lit. = literal, literally
marg. = margin, marginal (reading)
masc. = masculine
mean. = meaning
ment. = mental, mentally
mid. = middle
modif. = modified, modification
mor. = moral, morally
mus. = musical
nat. = native, natural, naturally, nature
neg. = negative, negatively
obj. = object, objective, objectively
or. = origin, original, originally
orth. = orthography, orthographical, 
orthographically
Pal. = Palestine
part. = participle
pass. = passive, passively
patron. = patronymic, patronymically
perh. = perhaps
perm. = permutation (of allied letters)
pers. = person, personal, personally
Pers. = Persia, Persian, Persians
phys. = physical, physically
plur. = plural
poet. = poetry, poetical, poetically
pos. = positive, positively
pref. = prefix, prefixed
prep. = preposition, prepositional, prepositionally
prim. = primitive



prob. = probable, probably
prol. = prolonged, prolongation
pron. = pronominal, pronominally, pronoun
prox. = proximate, proximately
rad. = radical
recip. = reciprocal, reciprocally
redupl. = reduplicated, reduplication
refl. = reflexive, reflexively
rel. = relative, relatively
relig. = religion, religious, religiously
second. = secondarily, secondary
signif. = signification, signifying
short. = shortened, shorter
sing. = singular
spec. = specific, specifically
streng. = strengthening
subdiv. = subdivision, subdivisional, subdivisionally
subj. = subject, subjective, subjectively
substit. = substituted
superl. = superlative, superlatively
symb. = symbolical, symbolically
te. = technical, technically
tran. = transitive, transitively
transc. = transcription
transp. = transposed, transposition
unc. = uncertain, uncertainly
var. = variation

See also:
Signs Employed in the Hebrew 
Signs Employed in the Greek 
Symbol List--Strong's Greek Bible 



Symbol List--Strong's Greek Bible

 Following is a list of abbreviations and symbols used in Strong's Dictionary of the Words in the Greek 
New Testament:

abst. = abstract (-ly)
acc. = accusative (case)
adv. = adverb (-ial) (-ly)
aff. = affinity
alt. = alternate (-ly)
anal. = analogy
app. = apparent (-ly)
caus. = causative (-ly)
cer. = ceremony, 
ceremonial(-ly)
Chald. = Chaldee
Chr. = Christian
coll. = collective (-ly)
comp. = comparative, compare, comparatively, compound (-s)
concr. = concrete (-ly)
corr. = corresponding
dat. = dative (case)
der. = derivation, derivative, derived
dim. = diminutive
dir. = direct (-ly)
E. = East
eccl. = ecclesiastical (-ly)
Eg. = Egypt (-ian)
ell. = ellipsis, elliptical (-ly)
eq. = equivalent
esp. = especially
euph. = euphemism, euphemistic, euphemistically
ext. = extension
fem. = feminine
fig. = figurative (-ly)
for. = foreign
gen. = genitive (case)
Gr. = Greek
Heb. = Hebraism, Hebrew
i.e. = id est, that is
imper. = imperative
imperf. = imperfect
impers. = impersonal (-ly)
impl. = implication, implied
incl. = including
ind. = indicative (-ly)
indiv. = individual (-ly)
inf. = infinitive
inh. = inhabitant (-s)
intens. = intensive (-ly)



intr. = intransitive (-ly)
invol. = involuntary, involuntarily
irr. = irregular (-ly)
Isr. = Israelite (-s), Israelitish
Jer. = Jerusalem
Lat. = Latin
lit. = literal (-ly)
mean. = meaning
ment. = mental (-ly)
mid. = middle (voice)
mor. = moral (-ly)
mult. = multiplicative
nat. = natural (-ly)
neg. = negative (-ly)
neut. = neuter
obj. = objective (-ly)
obs. = obsolete
or. = origin (-al) (-ly)
Pal. = Palestine
part. = participle
pass. = passive (ly)
perh. = perhaps
pers. = person (-al) (-ly)
phys. = physical (ly)
pl. = plural
pos. = positive (-ly)
pref. = prefix (-ed)
prim. = primary
prob. = probably
prol. = prolongation, prolonged
prim. = primary
prob. = probably
prol. = prolongation, prolonged
pron. = pronominal (-ly), pronoun
prop. = properly
redupl. = reduplicated, reduplication
refl. = reflexive (-ly)
rel. = relative (-ly)
Rom. = Roman
sing. = singular
spec. = special (-ly)
subj. = subjective (-ly)
sup. = superlative (-ly)
tech. = technical (-ly)
term. = termination
trans. = transitive (-ly)
transp. = transposed, transposition
typ. = typical (-ly)
unc. = uncertain
var. = variation, various
voc. = vocative
vol. = voluntarily, voluntary

See also:
Signs Employed in the Hebrew 
Signs Employed in the Greek 



Symbol List--Hebrew Bible 



Signs Employed in Strong's Greek

 
+ (addition)--Denotes a rendering in the Authorized Version (AV) of one or more Greek words in 

connection with the one under consideration.

X (multiplication)--Denotes a rendering in the AV that results from an idiom peculiar to the Greek.

 

( ) (parenthesis)--In the renderings from the AV, denotes a word or syllable sometimes given in 
connection with the principal word to which it is annexed. 

 

[ ] (bracket)--In the rendering from the AV, denotes the inclusion of an additional word in the Greek. 

See also:
Signs Employed in the Hebrew



Signs Employed in Strong's Hebrew

 

+ (addition)--Denotes a rendering in the Authorized Version (AV) of one or more Hebrew words in 
connection with the one under consideration.

X (multiplication)--Denotes a rendering in the AV that results from an idiom peculiar to the Hebrew.

 

( ) (parenthesis)--In the renderings from the AV, denotes a word or syllable sometimes given in 
connection with the principal annexed. 

 

[ ] (bracket)--In the rendering from the AV, denotes the inclusion of an additional word in the Hebrew. 

Comments--At the end of a rendering from the AV, denote an explanation of the variations from the 
usual form.

See also:
Signs Employed in the Greek 



Using a Mouse

 You'll be selecting QuickVerse options using either the keyboard or a Microsoft (or compatible) mouse. 
Before you run QuickVerse, make sure the "mouse driver" software provided with the mouse has been 
properly installed. If you have questions about mouse installation, consult the installation instructions 
included with your mouse package.

Because most Windows users tend to use a mouse, we emphasize mouse operation in our program 
documentation and in the online help. If you are new to mouse operations, please refer to your Windows 
manual for assistance.

See also:
Operating Buttons 
Shortcut Keys 



Operating Buttons

 Command buttons can perform actions, complete actions, and open windows to additional program 
features. They look much like buttons on any electronic device, but rather than "pressing" the button, you 
click on it with your mouse or press one or two associated keys on your keyboard. This is called 
"executing" the button.

To execute a button, do one of the following:

* Position the mouse cursor on it and click.

* Press and hold the Alt key and press a button's highlighted pick letter (if any).

* Press the arrow keys or Tab until the cursor or highlight has moved to the desired button; then 
press Enter.

For example, in the Open Bible dialog, after you've selected the Bible and note file you would like to open, 
click OK to open the translation. 

Common buttons you'll see include: 

 

 

Click on each button shown here to pop up a description of that button's function. 

Buttons on the icon bar operate in the same manner as buttons in dialogs. Simply place the pointer over 
the button you wish to activate, and click the left mouse button.



OK Button

Click OK when you've made your selections in a dialog box and wish to 
complete the action. 



Help Button

Click on this button in a dialog box to open context-sensitive help for the 
dialog box you have open. 



Cancel Button

Click on this button in a dialog box if you wish to abandon any selections 
or changes you've made in the open dialog box.



Using Shortcut Keys

 You can use the following shortcut keys to carry out the designated functions. To use the key 
combinations, press and hold the first key indicated; then press the second key listed. For example, to 
access the Go To Verse function, press and hold the Control key and press the letter G on your keyboard. 
If two sets of key combinations are listed, you have the option of using either set to access those 
functions.

Online Help F1
Cut Ctrl+X or Shift+Del
Copy Ctrl+C or Ctrl+Ins
Paste Ctrl+V or Shift+Ins
Delete Del
Undo Ctrl+Z or Alt+Backspace
Go To Verse Ctrl+G
Previous Reference Ctrl+R
Search Ctrl+S
Quick Search Ctrl+Q
List (Search) Occurrences Ctrl+L
List Notes Ctrl+N
Write Notes Ctrl+W
Book Notes F2
Chapter Notes Shift+F2
KJV Word Study Ctrl+K
NASB Word Study Ctrl+Shift+K
Bold Ctrl+B
Italic Ctrl+I
Underline Ctrl+U
Open Bible Ctrl+O
Close Bible Ctrl+F4
Close All Bibles Ctrl+A
Next Window Ctrl+F6
Cascade Shift+F5
Tile Shift+F4
Synchronize Windows Ctrl+Y
Strong's Dictionary Ctrl+D
NASC Dictionary Ctrl+Shift+D
Close QuickVerse Alt+F4

See also:
Operating Buttons 
Using a Mouse 



Printing a Single Verse

To print one verse, select the verse you want to print. Make sure the current verse marker (>) points to the 
verse. Then select Print from the File menu and choose Current Verse. Windows verifies that the printer is 
connected and online before it prints the verse. (To change your default printer, use the Windows Control 
Panel. If you get an error message, make sure your printer is plugged in, turned on, connected to the 
computer, online, and full of paper.)

NOTE: If you print one verse at a time, each verse prints on a separate sheet of paper, 
due to Windows conventions. To print several noncontiguous verses on a single sheet of 
paper, you must create an index with these verses and print the index, or print a 
passage (for example: John 3:16-18; Eph 2:8-9).

See also:
Print Setup Options 



Printing Selected Verses

Select Print from the File menu and choose Selected Verses to print verses currently selected (that is, 
highlighted by dragging the mouse through the verses in the active Bible window).

Select Print from the File menu and choose All Search Verses to print each verse that matches your last 
search. QuickVerse prints the verses in the translation you used for the search, regardless of the active 
Bible window on your screen. For example, perhaps you performed a Reference search on Psalm 23 in 
the KJV, but you switched to the NIV to compare verses. If you select Print, then choose All Search 
Verses from the NIV, QuickVerse prints Psalm 23 in the King James version.

See also:
Print Setup Options 



Printing Search Verses

Select Print from the File menu and choose All Search Verses to print each verse that matches your last 
search. QuickVerse prints the verses in the translation you used for the search, regardless of the active 
Bible window on your screen. For example, perhaps you performed a Reference search on Psalm 23 in 
the KJV, but you switched to the NIV to compare verses. If you select Print, then choose All Search 
Verses from the NIV, QuickVerse prints Psalm 23 in the King James version.

See also:
Print Setup Options 



Printing a Passage

Select Print from the File menu and choose A Passage to print a number of consecutive verses. For 
example, to print a passage for a Christmas program, type Luke 2:1-20 in the Passage field in the Print 
Passages dialog that opens. Select the desired translation in the field to the right. (If not already open, it 
opens automatically.) Click OK. QuickVerse sends all 20 verses to your printer.

See also:
Print Setup Options 



Printing an Index

Select Print from the File menu and choose Index to print all verses in your open index file. Each of the 
verses in the index file will be sent to the printer.

See also:
Print Setup Options 



Printing a Note

To print a note, select Print from the File menu; then choose Note. The current note is sent to the printer.

See also:
Print Setup Options 



Word List

This button is available in the Search dialog when your cursor is 
positioned in the Phrase field. Click the button to display an alphabetical 
list of every word mentioned in the Bible and the number of times it 
occurs. 



More Verse Format Options

The Options listed on the right side of the Clipboard Setup dialog provide you with complete control over 
the format of the verses you copy to the clipboard for pasting to a word processor. 

Choose Clipboard Setup from the Edit menu to open the Clipboard Setup dialog. Use as many options as 
you would like to create a format tailored to your needs. 

The Options in the setup dialog are as follows:

Abbreviate book names--The book name appears in shortened form in the reference.

Include translation name--The translation abbreviation is placed in the verse reference. The translation 
abbreviation will be enclosed in parenthesis if you have not specified any delimiters. 

Put quotes around verses--Quotation marks are placed around each verse you paste. 

Include book notes--Book notes you've attached to a verse are pasted along with the verse.

Include chapter notes--Chapter notes you've attached to a verse are pasted along with the verse.

Include verse and word notes--Verse and word notes you've attached to a verse are pasted along with 
the verse. 

Enable boldface--Boldface words in the Bible's text or in your notes will appear in boldface. Normal text 
is used for boldface items if this option is not marked.

Enable italics--Italicized words in the Bible's text or in your notes will appear in italics. Normal text is 
used for italicized items if this option is not marked.

Enable underline--Underlined words in the Bible's text or in your notes will be underlined. Normal text is 
used if this option is not marked.

Use color for words of Christ--Words of Christ will include color information. The default color will be 
used if this option is not marked. If you check this option, you must also designate the color you would 
like to use. To do so, select Colors from the Fonts menu. 

NOTE:    If you check any one or more of the enable boldface, enable italics, enable 
underline options and use color for words or Christ, then QuickVerse will supply both 
plain text and rich text format (RTF) representations to the clipboard. Your word 
processor will choose which format to paste.

QuickVerse does NOT supply font information with the RTF text. This is to allow your 
word processor to set the font. Some word processors use the default Windows font and 
not the current font. 

See also:
Clipboard Verse Formats 
Pasting to a Word Processor



Setting Up Word Processor Customization

To set up QuickVerse to link to your word processor:

1. Select Customize WP from the Options menu. The Customize Word Processors dialog box will 
appear.

2. Check the Modify box to the left of the application you want to link to QuickVerse. (You can select 
as many as you like.)

3. If your application does not appear on the list, add it by typing its caption (the program name as it 
appears in the title bar of the program's main window) in one of the empty boxes in the Word 
Processor Caption column (or by typing over an existing entry). You need only enter enough 
characters from the caption so that it can be distinguished from other applications.

4. When you have finished your entries in this box, press the Update button to tell QuickVerse to 
find the checked applications and enable QuickVerse pasting.

Command IDs
The numbers in the ID column are command identification numbers. Command IDs are numbers that 
Windows uses to tell a program which of its menu items has been selected by the user. Each menu item 
has a unique ID number.

The default ID number (45000) included in this dialog box is known to be unique for the programs listed 
(therefore, they should not conflict with other ID numbers in these programs); however, the program ID 
you assign for any programs you add to this list must be unique within that program. That is, if by chance 
your program already has a command identified by the number 45000, it will not be able to recognize the 
QuickVerse Customization link command or its own command that uses that ID (or may exhibit 
unpredictable behavior because of the conflict). 

We suggest that you try leaving the ID number set at 45000. Then, if you find that you are unable to 
complete the link or if selecting some other menu item activates QuickVerse Paste or shows unexplained 
behavior, you will know that the number already exists in your program and you will need to assign a 
different one. You can assign any number between 0 and 65535. High numbers usually work best.

See also:
Creating the Link 



Creating the Link

If your word processor was not running when you created the QuickVerse link in Setting Up Word 
Processor Customization, open it and return to the Customize Word Processors dialog box. Press the 
Update button to initialize the link. Whenever you make any changes to the Customize Word Processor 
dialog box (including deselecting a link or changing an ID number), execute Update to activate the 
change.

You may create a link between QuickVerse and another application at any time. If neither program is 
running, start the other application and then start QuickVerse. QuickVerse may be able to establish the 
link when it starts. Once both programs are started, if the link is not yet established, make sure the 
customization setup (in the Customize Word Processors dialog box) is correct. Then press the Update 
button. 

NOTE:    For some applications, it may be necessary to pull down the Edit menu in that 
program once before starting the link. If the QuickVerse item still is not present, then it 
is likely that this method will not work with the other application. 

Some Windows applications modify their own menus while running, which can 
sometimes break the link between QuickVerse and the application. You can restore the 
link at any time by pressing the Update button on the Customize Word Processor dialog 
box.

See also:
Accessing   QuickVerse   from your Word Processor  



Accessing QuickVerse from Your Word Processor

Once you have established the QuickVerse   link   to your word processor, you will be able to bring 
QuickVerse Bible text into your word processor whenever you have both programs running. You will 
notice that a new QuickVerse Paste menu item now appears in your word processor Edit menu. To 
initiate a paste:

1. From the location in your document where you want the Bible text to appear, select the 
QuickVerse Paste menu item. The QuickVerse Paste dialog box appears.

2. Enter the reference for the verse or passage you want to import, using the same conventions for 
designating verses in a QuickVerse search (see Reference Searches for details).

3. Then select the translation from the pull down list on the right side of the dialog. (Note:    You must 
have other translations installed in order to copy from them.)

4. Click OK. The Bible text appears in your word processed document (or click Cancel to escape or 
Help for further information). 



Saving Verses to a File

To save verses to a file:

1. Make sure a file is open in the active Bible window. See Opening Files.

2. Select File Setup options, if desired.

3. Choose File from the File menu.

4. Choose one of the following from the File submenu:

* Current Verse. Saves the current verse (the one with the current verse marker [>] beside it) to 
the file.

* Selected Verses. Saves the verses currently selected (that is, highlighted by dragging the mouse 
in the current Bible window), if any, to the file. 

* All Search Verses. Saves all the verses matching your last search to the file. 

* A Passage. Saves a range of chapters, books, or verses to the file. See the File Passage dialog 
box.

* Index. Saves all verses in the open index to the file.

* Note. Saves the current note from the current Bible window.

To view the verses in a file, you must open the file in a word processor. 

See also:
Closing Files 



Data Entry Procedures

 Many QuickVerse windows and dialog boxes display blank spaces, called fields, ready for you to enter 
information. You'll enter the information much like you would using any word processor. 

When you first access a window or dialog box, a highlight bar or blinking cursor often appears in the first 
field. This indicates your current location on the screen. To move the highlight from field to field, use Tab 
or your mouse. For example, when you choose Search from the Search menu, the Search dialog opens 
with your cursor placed in the Phrase field. To move the cursor to the next field and others within the 
dialog, press Tab or click your mouse in the desired location. 

Fields are designed to accept the keyboard characters that you enter. As you start to type characters, a 
blinking cursor indicates your location within the field. Characters include letters, numbers, punctuation 
marks, spaces, and other keyboard symbols. 

See also:
Using a Mouse 
Using Shortcut Keys 



Pickletter

Many options can be accessed using your mouse, or by pressing Alt plus 
the option's associated pickletter. Pickletters are indicated by an underline. 
For example, to open the File menu using its pickletter, you would press 
Alt+F.



Screen Elements

To acquaint you with the components of the QuickVerse window, this topic describes the screen 
elements you'll be using to navigate the program. The upper section of the QuickVerse window is 
pictured below. Click on an area to pop-up the description of a particular screen element.

The status bar along the bottom of the QuickVerse window displays helpful information as you work with 
QuickVerse. For example, it displays the name of any open index or text files and briefly defines features 
in the menu. If you prefer, you can hide the status bar by choosing Status Bar from the Options menu. 

See also:
Menu Bar 
Using the Icon Bar 
Options Menu 



Delimiters

Once you've selected a verse format, use the Delimiters fields in the setup dialog to indicate the 
characters you would like to use to set the verse's reference apart from the rest of the text. You can use 
up to 4 characters as the delimiters. For example, you might enter << and >> in the Delimiters fields for 
the Reference Verse item to paste a verse formatted in this way: 

<<Gen 1:1 KJV>>    In the beginning God created the heaven and the earth.

After selecting a format and indicating the delimiters, look at the Example box below the Verse Format 
options to see if the verse looks the way you want. The sample in the box shows you how your pasted 
verse will appear using the options you specified. 

Note that when using the Paragraph style, two sets of delimiters are incorporated. The delimiters for the 
Verse Reference item are used for the first occurrence of the verse reference, and the delimiters you 
specify in the Paragraph Style fields are used for the embedded verse numbers in the text. 

See also:
Clipboard Setup 
File Setup 
Print Setup 



Verse Format in Files

 Open the File Setup dialog by choosing File Setup from the File menu. Use this dialog to indicate the 
options you would like to use for verses that you place in a text file. In the File Setup dialog, click the 
button beside the Verse Format option you want. Choose from: 

Reference Verse--Reference will precede the verse's text--for example, 
(1 Th 5:16 KJV) Rejoice evermore.

Verse Reference--Reference will follow the verse's text--for example, 
Rejoice evermore (1 Th 5:16 KJV).

Separate line--Verse will be pasted on a line below its reference--for example, 
1 Th 5:16 (KJV)
Rejoice evermore. 

Verse Only--Only the verse text will appear--for example, Rejoice evermore.

Reference only--Only the verse's reference will appear--for example,
1 Th 5:16 KJV. 

Paragraph style--Consecutive verses will be pasted directly after one another with each verse reference 
embedded in the text. The reference will be surrounded by the delimiting characters you specify to set it 
apart from the textfor example ...all men. {16} Rejoice evermore...

When you've chosen the verse format, select one or more items from the Options list in the File Setup 
dialog, clicking the box beside each option you want.

See also:
Delimiters



Options List for Setting Up Files

The Options in the File Setup dialog are as follows:

Abbreviate book names--The book name appears in shortened form in the reference.

Include translation name--The translation abbreviation is placed in the verse reference. The translation 
abbreviation will be enclosed in parenthesis if you have not specified any delimiters. 

Put quotes around verses--Quotation marks are placed around each verse you paste. 

Include book notes--Book notes you've attached to a verse are pasted along with the verse.

Include chapter notes--Chapter notes you've attached to a verse are pasted along with the verse.

Include verse and word notes--Verse and word notes you've attached to a verse are pasted along with 
the verse. 

See also:
Verse Format 
File Margins 
Delimiters 



File Setup Dialog Box

Open the File Setup dialog by choosing File Setup from the File menu. 
Select options that will affect the display of verses you place in a text file.



File Margins

 To set margins for a text file, open the File Setup dialog by choosing File Setup from the File menu. In the 
Margins box of the File Setup dialog, set the margins of your file by specifying the left and right verse 
margins in number of characters. On 81/2-inch x 11-inch paper, a standard line is 80 characters. To set one 
inch margins, type 10 for the left margin and 70 for the right. Note that to set the right margin, you must 
count the total number of characters from the left edge of the paper.

NOTE: When you file verses, QuickVerse inserts a hard carriage return at the end of 
each line of text. To prevent this, click the "Ignore margins" box at the bottom of the File 
Setup dialog. This produces continuous text with carriage returns only at the end of 
verses, making it easier to import Quick Verse files into your word processor.

If you plan to include your notes with verses you place in a file, type the left and right margins of the 
notes, also in characters. You can indent your notes to distinguish them from verses making them easier 
to read.

Click the OK button when you've completed the setup for the open file.

See also:
Adding Verses to a File 
Opening and Creating Files 



Verse Format for Printed Verses

Choose from the following formats for verses you print. Click on the option you wish to use in the Print 
Setup dialog box. Open the dialog by choosing Print Setup from the File menu.

Reference Verse--Reference will precede the verse's text--for example, 
(1 Th 5:16 KJV) Rejoice evermore.

Verse Reference--Reference will follow the verse's text--for example, 
Rejoice evermore (1 Th 5:16 KJV).

Separate line--Verse will be pasted on a line below its reference--for example, 
1 Th 5:16 (KJV)
Rejoice evermore. 

Verse Only--Only the verse text will appear--for example, Rejoice evermore.

Reference only--Only the verse's reference will appear--for example,
1 Th 5:16 KJV. 

Paragraph style--Consecutive verses will be pasted directly after one another with each verse reference 
embedded in the text. The reference will be surrounded by the delimiting characters you specify to set it 
apart from the textfor example ...all men. {16} Rejoice evermore...

See also:
Printer Margins 



Print Margins

 
In the Margins box of the Printer Setup dialog, set the margins of your file by specifying the left and right 
verse margins in number of characters. On 81/2-inch x 11-inch paper, a standard line is 80 characters. To 
set one inch margins, type 10 for the left margin and 70 for the right. Note that to set the right margin, you 
must count the total number of characters from the left edge of the paper.

If you plan to include your notes with verses you print, type the left and right margins of the notes, also in 
characters. You can indent your notes to distinguish them from verses making them easier to read.

Click the OK button when you've completed the setup for the verses you plan to print. You can open the 
dialog again at any time to change the selections you made for printing.

See also:
More Printing Options 
Printing Verses 



More Printing Options

 
The Options listed on the right side of the Printer Setup dialog provide you with complete control over the 
format of the verses you print directly from QuickVerse. Choose Print Setup from the File menu to open 
the Printer Setup dialog. 

Use as many options as you would like to create a format tailored to your needs. 

The Options in the setup dialog are as follows:

Abbreviate book names--The book name appears in shortened form in the reference.

Include translation name--The translation abbreviation is placed in the verse reference. The translation 
abbreviation will be enclosed in parenthesis if you have not specified any delimiters. 

Put quotes around verses--Quotation marks are placed around each verse you paste. 

Include book notes--Book notes you've attached to a verse are pasted along with the verse.

Include chapter notes--Chapter notes you've attached to a verse are pasted along with the verse.

Include verse and word notes--Verse and word notes you've attached to a verse are pasted along with 
the verse. 

Enable boldface--Boldface words in the Bible's text or in your notes will appear in boldface. Normal text 
is used for boldface items if this option is not marked.

Enable italics--Italicized words in the Bible's text or in your notes will appear in italics. Normal text is 
used for italicized items if this option is not marked.

Enable underline--Underlined words in the Bible's text or in your notes will be underlined. Normal text is 
used if this option is not marked.

Use color for words of Christ--Words of Christ will include color information. The default color will be 
used if this option is not marked. If you check this option, you must also designate the color you would 
like to use. To do so, select Colors from the Fonts menu. 

See also:
Printing Verses 
Delimiters 
Verse Formats 



Hebrew and Greek Word List

Press the Word List button to display the Hebrew and Greek word list. Use 
this feature to look up a word in the dictionary and view its definition. You 
can also use it to determine the Strong's number for a specific word.

In the Word List dialog, enter the word you want defined in the Word field. 
You can also use the scroll bar to view the list, then double-click on the 
word you want defined.



Previous Word

Press the Previous button in the Dictionary window to view the definition 
of the word assigned the Strong's number preceding the number indicated 
in the Strong's Number field at the top of the window.



Next Word

Press the Next button in the Dictionary window to view the definition of 
the word assigned the Strong's number following the number indicated in 
the Strong's Number field at the top of the window.



Close

Press the Close button when you've finished using the Dictionary. 



Help

Press the Help button if you need instructions on using the features of the 
open window or dialog. 



Hebrew and Greek Word List

    Use the Hebrew and Greek Word list to determine the Strong's number for a specific word. In the Word 
List dialog, you can enter a Strong's number in the Word field or use the scroll bar to view the list and use 
the mouse to highlight the word whose definition you want to view. 

When you've selected a word from the list or entered the Strong's number into the Word field, click OK. 
The Word List dialog will close and the definition for the word you chose will appear in the Strong's 
Dictionary window. You can then use the Strong's Dictionary window buttons to copy the definition to 
another location, or view the definitions of words around the word you selected.

See also:
Using Strong's Dictionary 



Strong's Number

A number used to identify the Hebrew and Greek transliterated words in 
the Strong's Concordance and the New American Standard Exhaustive 
Concordance (NASC). The number is preceded by an H or G, depending 
on the language (Hebrew or Greek) under consideration.

The indexing system was established by James Strong, who developed a 
concordance for the KJV Bible in the late 1880s.



QuickVerse Search Word List

The Word List, available from the Search dialog box, is a list of all the words in the selected translation of 
the Bible and the number of times they occur.

To use the list, position the cursor in the Phrase field of the Search dialog box and click on the Word List 
button. When the box opens, scroll through the list until the highlight is positioned on the word you want to 
use, then click on OK. The selected word appears in the Phrase field.

You can select phrases using the Word List by selecting each word in the phrase in order.

See also:
Using the Book List 
Using the Strong's Word List 



Using the Book List

The QuickVerse Book List is accessed from the Search dialog box. With the cursor positioned in the 
Reference field of the Search dialog box, the Book List button appears at the bottom. Click this button to 
display the Book List dialog box containing a list of all the books in the Bible.

Type the name of the book of interest in the Go To field, or use the arrow keys to scroll through the lists. 
Highlight the desired book, chapter, and verse in each list box. Press Enter or click the OK button to 
confirm your selection. Notice the reference you select from the list appears in the Go To field. When you 
click OK, you are returned to the Search dialog box, and the reference you selected appears in the 
Reference field.

See also:
Reference Searches 



Copy To Dialog for Concordances

 In the Copy To dialog for a concordance, select the destination for the selected definition by clicking on 
the option you want--an index or text file, the printer, or the Clipboard. The note margins specified in the 
file or print setup dialog, will be used if you choose to copy the definition to a text file or the printer. Click 
OK when you've made your selections and the definition will be sent to the destination you specified.



Copy To Dialog Box

 In the Copy To dialog, choose the destination for the selected definition by clicking on the option you 
want--an index or text file, the printer, or the Clipboard.

If you choose to copy the definition to a text file or the printer, the margins specified in the file or print 
setup dialog will be used. 

Click OK when you've made your selections. The definition will be sent to the destination you specified.

See also:
Print Setup 
Printing 
Pasting to a Word Processor 



Word List Dialog Box

The Word List, available from the Search dialog box, is a list of all the words in the Bible and the number 
of times they occur.

To use the list, position the cursor in the Phrase field of the Search dialog box and click on the Word List 
button. When the box opens, scroll through the list until the highlight is positioned on the word you want to 
use; then click on OK. The selected word appears in the Phrase field.

You can select phrases using the Word List by selecting each word in the phrase in order. For example, 
click on a word in the word list, and click OK. The word you selected appears in the Phrase field. Click the 
Word List button again and select another word. When you click OK, the second word you selected will be 
inserted after the first word in the Phrase field of the Search dialog. 

See also:
Using the Book List 



New Notes Dialog Box

In the New Notes dialog, type a description of the note file you're creating. You might want to enter some 
descriptive information about the types of notes you plan to write in the file you're creating. This 
description can help you identify the note file later. 

Also in the New Notes dialog, select the translation option. Select whether to use the note file with the 
current translation only or with all translations by clicking on the option you desire.
A note file used only with a specific translation can include all types of notes, including word notes, but 
can be used with only that translation. Use this type of note to write commentary on specific words in a 
verse.

A note file used with all translations can contain book, chapter, and verse notes, but can not contain word 
notes since specific words vary among different translations. Use this type of note file if you do not need 
word notes and want to be able to use the file with any translation.

Click OK when you're finished and the Note file will be created.



New Index Dialog Box

Type a brief description of the index in the Description field of the New Index dialog to help distinguish 
one index from another. For example, Marriage and love in the New Testament.

Then Choose one of the following to arrange the verses:

Sorted. QuickVerse automatically arranges verses in the order they appear in the Bible.

Unsorted. You arrange the verses as you add them. You can include the same verse more 
than once.

Click the OK button.



File Passage Dialog Box

In the File Passage dialog, type the range of verses you would like to place in the file. For example, you 
might type Gen 1:1-5:5. You can also select the translation for the passage. Click on the arrow at the right 
of the translation list field to view a list of translations, or use your up and down arrow keys to view each 
translation option. (Note that you may only select a translation which you have installed.) 

Click OK when you've selected the translation and entered the verse or verses you would like to place in 
the file. QuickVerse will save the range of chapters, books, or verses you specify to the open file. 

Note that QuickVerse recognizes most standard book abbreviations. You may also simply type enough 
letters of the book name to distinguish it from other books.



Control Menu Box

This button is in the upper-left corner of the QuickVerse Desktop. It lets 
you resize, move, maximize, and minimize the QuickVerse desktop, as 
well as exit the program.



Minimize Button

The Minimize button appears in the upper right corner of the QuickVerse 
desktop and the Bible window. Click on it with your mouse to reduce 
QuickVerse to an icon on your Windows desktop. The program still 
remains active.



Maximize Button

This button is in the upper right corner of the QuickVerse desktop, next to 
the minimize button. Click the Maximize button to enlarge the 
QuickVerse window so that it fills the screen.



Restore Button

After you enlarge a window using the maximize button, the Restore button 
appears in place of the Maximize button. Click the Restore button to return 
the window to its previous size.



Title Bar

The title bar appears at the top of the QuickVerse program screen and 
displays the name of the program. You'll also see title bars at the top of 
dialog boxes and other windows throughout the program. Use the title bar 
to identify the name of the dialog or window you're viewing. Often you 
can click and drag on the title bar to move the box to another location on 
your screen.



Control Menu Box--Bible Window

This button is in the upper-left corner of the QuickVerse Bible window. It 
lets you close, resize, move, maximize, and minimize the open Bible 
window



Buttons

Command buttons can perform actions, complete actions, and open 
windows to additional program features. They look much like buttons on 
any electronic device, but rather than "pressing" the button, you click on it 
with your mouse or press one or two associated keys on your keyboard. 
This is called "executing" the button.



Using Study Bibles

If you are using one of the Study Bible add-on modules for QuickVerse, you will notice some useful 
additions to your Bible and Note windows when the Study Bible is open. The Study Bible notes may 
contain commentary, cross references, or hotlinks to maps, charts, and pictures. 

For example, if you have purchased and installed The Believer's Study Bible, your Bible window will 
contain subject headings that provide a running commentary of the text. These are designed to help you 
locate specific passages in the Bible. In the Believer's Study Bible note window (BSB.NOT), you'll have 
access to cross references to verses, maps, and charts to enhance your study of the Bible. The verses, 
maps, and charts are accessed by double-clicking on the bold cross references and hotlinks that appear 
in The Believer's Study Bible.

To use these Bible Study features, you'll first need to open the Study Bible note file you want to use. 
Choose Open Notes from the Notes menu and select the appropriate note file. Once the file is open, you 
will find certain passages in the note window may contain cross references to verses, maps, charts, or 
pictures. By default, these references will appear in boldface green text, or in whatever color you select 
for verse references. (Use the Colors option on the Fonts menu to select this setting.) To view the verse, 
map, chart, or picture referenced, simply double click on the bold cross reference. If the reference is a 
map, chart, or picture, the item will open in a window on your screen. If the cross reference is another 
Bible verse, the Bible window will move to that passage.

See also:
Viewing Maps, Charts, and Pictures
Cross References 
Add-on Products for   QuickVerse   
Ordering Information 



Viewing Maps, Charts, and Pictures

When you double click on a (see map), (see chart), or (see picture) cross reference in a study Bible 
note window, the program opens a dialog box containing the appropriate image. The title of the graphic is 
displayed in the title bar of the dialog. 

You can view the chart, map, or picture on your screen, or you can click the Copy To button to copy it to a 
destination you select (such as the Windows clipboard or your printer).

For more information on printing and copying graphics, see How QuickVerse Handles Study Bible 
Graphics

If the picture is too large to fit in its dialog on your screen, the scroll bar along the edge of the dialog will 
be available. Click on the arrows at either end of the scroll bar to move the image being displayed.

When you have finished viewing the map, chart, or picture, click the Close button to return to the 
QuickVerse desktop.

NOTE: Maps, charts, and pictures cannot be modified in QuickVerse. Also, you cannot 
create or include additional images.

See also:
Cross References 
Using Study Bible Cross References 



How QuickVerse Handles Study Bible Graphics

The maps, charts, and pictures in QuickVerse add-on Study Bibles are stored as bitmaps. Bitmaps store 
the exact representation of an image on the screen. Therefore, they can be quickly and easily reproduced 
on your screen exactly as they were drawn. This makes bitmaps an ideal choice for presenting your Study 
Bible graphics right on the screen with the Bible text, notes, and other study aids.

While bitmaps work well on your display monitor, special care must be taken when they are copied to the 
printer or the Windows' Clipboard. Understanding some of the characteristics of bitmaps can help you 
handle these tasks better.

For more information on these tasks, see:
Printing Bitmaps 
Copying Bitmaps to the Clipboard 

NOTE:    QuickVerse is primarily a Bible study tool, not a graphics manipulation 
program. If you find these maps particularly helpful, you may be interested in PC Bible 
Atlas for Windows, Parsons Technology's collection of online maps of the biblical Holy 
Lands. For more information, or to order PC Bible Atlas, just call 1-800-223-6925.



Printing Bitmaps

Since printers normally have a higher resolution than video monitors, an exact reproduction of a bitmap 
on your screen would be very small on the printed page. To adjust for this difference when you print a 
bitmap, QuickVerse performs an operation called "stretching" on the bitmap. Stretching allows the 
program to represent the image at a reasonable size on the printed page.

In many cases, the bitmap must be stretched to three or four times its original size. Unfortunately, 
stretching can also distort the bitmap slightly. You'll notice this especially in the text of a bitmap which can 
become blocky and even jagged. The bitmaps are stretched as little as possible to optimize both size and 
appearance.

Adjusting Dithering and Intensity
You can greatly affect the quality of a printed bitmap with the settings you select for your printer or even 
the printer driver you choose. Many printer drivers have settings for "dithering" and intensity.

Dithering is a process of representing a solid color by using a pattern of alternating different colors For 
example, all of the maps and many of the pictures in QuickVerse Study Bibles are in color. If you do not 
have a color printer, these colors must be represented by dithering colors (in this case black and white) 
that blend to resemble the solid color. In the case of a non-color printer, dithering is performed to 
represent each of the bitmaps colors in one of several shades of gray. Many printer drivers have a control 
for the style of dithering such as course or fine.

Some of the maps and pictures have dark backgrounds and may look better by setting a printer intensity 
control to a lighter setting. There may be other settings that can be adjusted to improve the quality of the 
bitmap you are printing.

See also:
Printing 
Printing a Note 
Copying Bitmaps to the Clipboard 



Copying Bitmaps to the Clipboard

Bitmaps may be copied to the Windows Clipboard and then pasted into other applications that can 
receive them. Once a bitmap has been copied to the Clipboard, it is up to the receiving application to 
properly paste and display it.

To copy a bitmap (map, chart or picture) from QuickVerse to another program:

1. Go to the bitmap by clicking the appropriate colored link such as (see map).

2. With the bitmap open, click the Copy To button.

3. Open the other program or switch to it by pressing Ctrl+Tab until you access it, (or by selecting 
Switch To from the control-menu and choosing the program from the Task List).

4. From the other program, select Paste from the appropriate menu. Your QuickVerse bitmap 
should appear in the other program.

Several factors can affect how well this is done. One factor is color. Most of the bitmaps in QuickVerse 
are 16-color or less; some are 256-color. Although 16-color or two-color is adequate for charts and even 
maps, the pictures look much better when 256 colors are used.

QuickVerse is a sophisticated program that can handle these 256-color bitmaps correctly. However, once 
the bitmap is placed in the Clipboard, QuickVerse is no longer "involved." As noted earlier, the quality of 
the copy is the responsibility of the application performing the paste. Some less sophisticated graphics 
programs may perform well on bitmaps containing 16 or fewer colors, but not perform the necessary 
palette work to allow 256-color bitmaps to display properly. For instance, some versions of PaintBrush will 
not paste 256-color images from the Clipboard properly. More sophisticated graphics applications, such 
as Adobe Photoshop, handle these images correctly.

See also:
Printing 
Printing Bitmaps 



Transliterated

A transliterated word is spelled phonetically (the way it sounds) and 
written with English letters, rather than Hebrew or Greek characters. 



Tips for Using the NASC

 See the following topics for tips on using the New American Standard Exhaustive Concordance:
Symbols Used in the NASC
Abbreviations in the NASC Hebrew Dictionary 
Abbreviations in the NASC Greek Dictionary 
Duplicated Words in Concordances 
Words Not Included in Concordances 



Back

Click on the Back button in the Dictionary window to go back to the 
previously viewed definition (the second number in your History List). In 
this case, the number originally at the top of the History List is completely 
removed, and the second number moves up to become the first number on 
the list.



History List

Click on the the arrow button on the right side of the Strong's Number 
field to display a list of numbers you've already accessed. Clicking on a 
number from the list returns you to the definition for that word. In this 
case, the number is copied and added to the top of the list to indicate that it 
was the word accessed most recently. The number also retains its original 
position in the list so you can maintain an accurate history of your search.



Symbols Used in the NASC

 When you view a definition in the NASC Dictionary, the first item is always the Strong's reference number 
for that word. This is always followed by the transliterated Hebrew or Greek word.

Page References
If the word is Hebrew or Aramaic, the definition then lists a page and quadrant reference to A Hebrew and 
English Lexicon of the Old Testament by Brown, Driver, and Briggs (Oxford University Press). The lower 
case letter refers to the quadrant on that page that contains an article discussing the Hebrew or Aramaic 
word. (The a indicates the upper left quadrant of the page, b is lower left, c is upper right, and d is lower 
right.)

Word Origins
Next the definition lists the origin or derivation of the word. References used, and their meanings, include:

(Ara.)      This word is Aramaic rather than Hebrew.

from H1981      This word is derived from word H1981 in this dictionary.

from the same as H3742      This word is derived from the same root word as word H3742 in the NASC 
dictionary.

from an unused word      This word is derived from a word that is not found in the Hebrew Old Testament.

of Heb. or. H6939      This Greek word is derived from a word of Hebrew origin with the reference number 
H6939 and may be found in the NASC dictionary.

prim root or prim word      This word is called primitive because it is not derived from any other known 
word in the Hebrew (or Greek) language.

Meanings
Following the second semicolon in each entry is the general meaning of the word. If the word is a proper 
name, a note of identification is given. In some cases, the word (or words) that make up the name is 
given in quotation marks.

Notations
Meanings of the words are dependent upon the context in which the words are found. Following the colon 
dash (:--) in each entry is a list of New American Standard Bible translations of the word. The following 
additional notations may appear:

(m) Indicates that a specific occurrence of the key word or expression may have a notation in the 
margin of the New American Standard Bible.

(*) Indicates that the key word represents two or more Hebrew or Greek words. 
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Abbreviations in the NASC Hebrew Dictionary

 The following abbreviations are used in the NASC Hebrew dictionary:

abb. = abbreviated, abbreviation
act. = active, actively
adj. = adjective
adv. = adverb, adverbial
appar. = apparent, apparently
Ara. = Aramaic
Assyr. = Assyrian
Bab. = Babylon, Babylonian
card. = cardinal
conjunc. = conjunction
contr. = contracted, contraction
corr. = corresponding
denom. = denominative
der. = derivation, derivative, derived
desc. = descended, descendant(s)
E. = east, eastern
Eg. = Egypt, Egyptian
equiv. = equivalent
fem. = feminine
for. = foreign
Heb. = Hebrew
i.e. = id est, that is
inhab. = inhabited, inhabitant
intens. = intensive
interj. = interjection
Isr. = Israel, Israelite
Jer. = Jerusalem
masc. = masculine
N. = north, northern
neg. = negative
or. = origin
ord. = ordinal
orth. = orthographic
Pal. = Palestine
part. = participle
pass. = passive
perh. = perhaps
Pers. = Persian
pl. = plural
pref. = prefix
prep. = preposition, prepositional
prim. = primary, primitive
prob. = probably
prol. = prolongated, prolongation
pron. = pronoun
q.v. = quod vide, which see



redupl. = reduplicated, reduplication
rel. = relative
S. = south, southern
short. = shortened
suff. = suffix
transp. = transposition
unc. = uncertain
var. = variation
vb. = verb
W. = west, western
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Abbreviations in the NASC Greek Dictionary

 The following abbreviations are used in the NASC Greek dictionary:

abb. = abbreviated, abbreviation
acc. = accusative (case)
act. = active
adj. = adjective
adv. = adverb, adverbial
alt. = alternate
anal. = analogy
aor. = aorist
appar. = apparent, apparently
Ara. = Aramaic
Arab. = Arabic
art. = article
card. = cardinal
caus. = causative
Chr. = Christian
cf. = compare
comp. = compound
conjunc. = conjunction
contr. = contracted, contraction
cop. = copulative
cptv. = comparative, comparatively
dat. = dative (case)
def. = definite
der. = derivation, derivative, derived
desc. = descended, descendant(s)
dim. = diminutive
E. = east, eastern
Eg. = Egypt, Egyptian
equiv. = equivalent
esp. = especially
etc. = et cetera
euph. = euphemism
ext. = extension
fem. = feminine
fig. = figurative, figuratively
for. = foreign
fut. = future
gen. = genitive (case)
Gr. = Greek
Heb. = Hebrew
i.e. = id est, that is
imper. = imperative
imperf. = imperfect
impl. = implied, implication
incl. = including
ind. = indicative



indef. = indefinite
inf. = infinitive
inhab. = inhabited, inhabitant
intens. = intensive 
interj. = interjection
interrog. = interrogative
Isr. = Israel, Israelite
Jer. = Jerusalem
Lat. = Latin
lit. = literal, literally
masc. = masculine
mean. = meaning
mid. = middle (voice)
mult. = multiplicative
N. = north, northern
neg. = negative
neut. = neuter
nom. = nominative
N.T. = New Testament
num. = number
obs. = obsolete
onomatop. = onomatopoeia, onomatopoeic
or. = origin
ord. = ordinal
O.T. = Old Testament
Pal. = Palestine
part. = participle
pass. = passive
perf. = perfect
perh. = perhaps
Pers. = Persian
pers. = person, personal
pl. = plural
poss. = possessive
pref. = prefix 
prep. = preposition, prepositional
pres. = present
prim. = primary, primitive
prob. = probably
prol. = prolongated, prolongation
pron. = pronoun
q.v. = quod vide, which see
recip. = reciprocal
redupl. = reduplicated, reduplication
refl. = reflexive
rel. = relative
Rom. = Roman
S. = south, southern
sing. = singular
spec. = specifically
substs. = substantive
suff. = suffix
superl. = superlative
unc. = uncertain
vb. = verb
W. = west, western
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Copy To Button

When a definition is displayed in a concordance Dictionary window, click 
this button to transfer the definition to the open text or index file, to the 
printer, or to the Windows Clipboard. Clicking the Copy To Button opens 
the Copy To Dialog Box.where you can make your selections.

 




